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Part I

Installation

1 Software versions

Following software versions were tested for full X2C® functionality:

Software Version

Required:

Scilab (www.scilab.org) 6.1.1

Optional (for standalone operation):

Java Runtime Environment Java SE 8 / ojdkbuild 13 JRE

Optional (for documentation):

MiKTeX (www.miktex.org) 2.9

Doxygen (www.doxygen.org) 1.8.10

Graphviz (www.graphviz.org) 2.38

Optional (for programming):

TI Code Composer Studio 11.x

TI Code Generation Tools c2000_16.9.5.LTS / arm_16.9.4.LTS

Keil µVision® 5.x

Microchip MPLAB® X 5.xx

Microchip XC16 1.xx

Different versions of these programs may work but without warranty.

2 Setup with Scilab & Xcos support

2.1 Installation

1. Open Scilab and with the File Browser navigate to
<X2C_ROOT>\System\Scilab\Scripts. Right click on setup.sce and click Execute in
Scilab.

2. Restart Scilab

3. The setup command creates a X2C configuration file which will automically load X2C
libraries and palettes at startup of Scilab .

2.2 Uninstallation

1. Open Scilab and execute the command initX2C(%f) in the Scilab console.

2. Restart Scilab

3. Once above command was execeuted, the X2C configuration file is deleted and Scilab
will not load any X2C libraries or palettes anymore.

For the unlikely event that Scilab freezes at startup and remains in a deadlock state, the
deinstallation can be done manually by deleting the file scilab.ini located in the Scilab home
directory (for Windows typically C:\Users\<your user name>\AppData\Roaming\Scilab\scilab-
6.x.x).
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3 Setup of Java for standalone operation

In X2C standalone operation, this means only X2C Communicator and Scope are to be used,
installation and setup of Scilab is not necessary. However, a Java runtime environment is
required.
The recommended Java software is OpenJDK. The ojdkbuild project provides, inter alia,
Microsoft Windows Installer (MSI) files by using the source code of OpenJDK.
Following setup steps are required to setup ojdkbuild for X2C :

1. Download the appropriate MSI installer from the website (the file name starts with
’java-13-openjdk-jre’)

2. Run the installer

3. When the installer reaches the ’Custom Setup’ step, be sure the following additional
options are enabled/selected:

(a) Click on the small ’plus’ symbol next to the ’OpenJDK JRE’ icon to show the list of
available options

Figure 1: Setup Options

(b) Ensure these options are enabled:

• Windows Registry

• PATH Variable

• JAVA_HOME Variable

• JAR Files Association
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Figure 2: Selected Setup Options

4. Wait for the installer to complete

You may check the successful Java setup by running the X2C Communicator. A double click
on the ’Communicator.jar’ file in the <X2C ROOT>\System\Java directory should open the
Communicator application.

4 Configuration of Code Composer Studio

4.1 Install the TI v16.9.5 compiler

It is necessary to use the compiler version TI v16.9.5 in Code Composer Studio in combination
with X2C . Navigate to Project → Properties click General and in the Advanced settings
area see what compiler versions are available. It is necessary to use the compiler version TI
v16.9.5. If this version is not selectable go to Help → Install new Software and in the Work
with drop down menu choose Code Generation Tools Update. In the section TI Compiler
Updates find C2800 Compiler Tools Version 16.9.5 and mark it as seen in Figure 3. Click
Next and install the update. Now go back to the Project Properties and change the compiler.
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Figure 3: Code Composer Studio Compiler Download

4.2 Texas Instruments target processor types

4.2.1 Supported processors families

Currently the following Texas Instruments processor families are supported by X2C .

• TI C28x 32-Bit CPU

• TI TM4C12x 32-Bit CPU (ARM Cortex-M4 core)

4.2.2 Change target processor in Code Composer Studio

In the following section file names may vary with different processor types.

1. Import the Blinky demo application in Code Composer Studio (see Section 17 for more
information).

2. Change the Predefined symbols (see Section 4.3) suitable for the used processor type.

3. With the OS file browser navigate to the controlSUITE subdirectory \device_support
and search for your processor type
(e.g. C:\ti\controlSUITE\device_support\f2806x\v130\F2806x_headers).

4. Copy the folders cmd, include and source into the project directory
<PROJECT_DIRECTORY>\TexasInstruments and replace the existing folders from
the processor used in the Blinkdy demo application.

5. In Code Composer Studio open the F28xxx_Device.h file in the folder
<PROJECT_DIRECTORY>\TexasInstruments\include. In the section User To Select
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Target Device search for your processor and change the 0 to TARGET. An example is
shown in Figure 4.

Figure 4: Change processor type in the device.h file

6. In Code Composer Studio open the files Hardware.h and X2cDataTypes.h and adapt
the file names in the include directives for the F28xxx_Device.h file.

4.3 Change predefined Symbols

The X2C project uses predefined symbols to give the preprocessor information before
compiling the project. Navigate to Project → Properties open Build → C2000 Compiler →
Predefined Symbols.
Currently three different processor families can be choosen

• __GENERIC_TI_C28X__ for Texas Instruments Processors

• __GENERIC_ARM_ARMV7__ for ARM Processors

• __GENERIC_MICROCHIP_DSPIC__ for Microchip Processors

The definition

• __CUSTOM_DATATYPE_DEFINITIONS__

is needed to avoid compiler warnings caused by multiple typedefs.

In addition the definition

• SCOPE_SIZE=8000

like seen in Figure 5 needs to be made. The value of Scope Size is changeable and depends
on the intended application and the used target processor. In the Blinky demo applications
these values are already defined.

10



Figure 5: Predefined symbols for generic processor type in Code Composer Studio

5 Configuration of MPLAB® X

5.1 Install the XC16 compiler

When working with MPLAB X the compiler to build the project has to be installed manually.
Which compiler is needed depends on the used processor type. In the demo application
Blinky the xc 16 v1.21 compiler from the Microchip web page
(http://www.microchip.com/pagehandler/en_us/devtools/mplabxc/) can be used.

5.2 Microchip target processor types

5.2.1 Supported processors families

Currently the following Microchip processor families are supported by X2C .

• dsPIC 16-Bit CPU

5.2.2 Change target processor in MPLAB X

Right click on the Project → Properties. In the Configuration area Devices can be picked in
the drop down menu. Click OK to save the changes.

5.3 Change predefined Symbols

The X2C project uses predefined Symbols to give the preprocessor information before
compiling the project. In the the sample project these symbols are already defined. Right
click on the Projectname → Properties → XC16 Global Options → xc16-gcc to eventually
change them. In the section Define C macros a list of defines is available as seen in Figure 6.
Depending on the used target processor three different processor families can be choosen

11

http://www.microchip.com/pagehandler/en_us/devtools/mplabxc/


• __GENERIC_TI_C28X__ for Texas Instruments Processors

• __GENERIC_ARM_ARMV7__ for ARM Processors

• __GENERIC_MICROCHIP_DSPIC__ for Microchip Processors

In addition the definition

• SCOPE_SIZE=5000

like seen in Figure 6 needs to be made. The value of Scope Size is changeable and depends
on the intended application and the used target processor. In the Blinky demo applications
these values are already defined.

Figure 6: Predefined Symbols in MPLAB X
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Part II

General

6 Introduction to X2C®

6.1 Boolean data representation

Boolean data is based on the header stdbool.h introduced in C99 in the C Standard Library
for the C programming language.

Bool

Implementation type Boolean

Format C99

Minimum value 0 (false)

Maximum value 1 (true)

6.2 Fixed point data representation

6.2.1 Standard signals

Standard signals are symmetrically scaled about zero and their scaling range is ]-1...1[.
In a case of an overflow the signal will be limited to 1 (or -1 respectively). For example a
subtraction of a signal with value 0.5 from a signal with value -0.7 will lead to a signal with
value -1.
Depending on the chosen implementation the values are handled in one of the following
formats:

FiP8

Implementation type 8-bit fixed point

Format Q7

Minimum value −0.992 187 500

Maximum value 0.992 187 500

Resolution 0.007 812 500

FiP16

Implementation type 16-bit fixed point

Format Q15

Minimum value −0.999 969 482 421 875

Maximum value 0.999 969 482 421 875

Resolution 0.000 030 517 578 125
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FiP32

Implementation type 32-bit fixed point

Format Q31

Minimum value −0.999 999 999 534 339

Maximum value 0.999 999 999 534 339

Resolution 0.000 000 000 465 661

6.2.2 Unlimited/Unbalanced signals

The scaling of unlimited/unbalanced signals is [-1...1[. While the standard signals omit one
value to achieve a symmetrical value range, the unlimited (or also called unbalanced) signals
utilize the full value range which leads to a slightly unbalanced value range. As the name
implies unlimited signals won’t be limited. In fact unlimited signals utilize wrapping/overflow
functions of the DSP. For example a subtraction of a signal with value 0.5 from a signal with
value -0.7 will lead to a signal with value 0.8.
So the primary use of the unlimited signal is as angular signal where (-1...1) corresponds to
(-π...π).
Depending on the chosen implementation the values are handled in one of the following
formats:

FiP8

Implementation type 8-bit fixed point

Format Q7

Minimum value −1.000 000 000

Maximum value 0.992 187 500

Resolution 0.007 812 500

FiP16

Implementation type 16-bit fixed point

Format Q15

Minimum value −1.000 000 000 000 000

Maximum value 0.999 969 482 421 875

Resolution 0.000 030 517 578 125

FiP32

Implementation type 32-bit fixed point

Format Q31

Minimum value −1.000 000 000 000 000

Maximum value 0.999 999 999 534 339

Resolution 0.000 000 000 465 661
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6.3 Floating point data representation

6.3.1 Standard signals

The standard signals in floating point format are not restricted, the full value range according
to the IEEE 754 standard is available.

Float32

Implementation type 32-bit floating point

Format IEEE 754

Minimum value −3.4028234663852885981170418348452e+ 38

Maximum value 3.4028234663852885981170418348452e+ 38

Resolution ±1.1754943508222875079687365372222e− 38
(normalized)

Float64

Implementation type 64-bit floating point

Format IEEE 754

Minimum value −1.797693134862315708145274237317e+ 308

Maximum value 1.797693134862315708145274237317e+ 308

Resolution ±2.2250738585072013830902327173324e− 308
(normalized)

6.3.2 Unlimited/Unbalanced signals

Contrary to their names the unlimited/unbalanced signals in floating point format are limited
to [−π,+π]. All other properties are similar to the unlimited signals in fixed point format.

Float32

Implementation type 32-bit floating point

Format IEEE 754

Minimum value −3.1415926535897932384626433832795

Maximum value 3.1415926535897932384626433832795

Resolution ±1.1754943508222875079687365372222e− 38
(normalized)

Float64

Implementation type 64-bit floating point

Format IEEE 754

Minimum value −3.1415926535897932384626433832795

Maximum value 3.1415926535897932384626433832795

Resolution ±2.2250738585072013830902327173324e− 308
(normalized)
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6.4 Restrictions

6.4.1 Algebraic loops

Algebraic loops as depicted in Figure 7a are not possible due to a execution order problem.
Therefore a block is required which breaks the loop at a specific position. This can be
achieved by inserting a block with no direct feedthrough functionality, e.g. Block: LoopBreaker
from the General-library or Block: Delay from the Control-library (see Figure 7b).

(a) forbidden (b) allowed

Figure 7: Algebraic loops

6.4.2 Connection of blocks with different implementations

Though blocks with different implementations are allowed (and computed correctly) in the
same model, connections of ports with different datatypes are not permitted. The conversion
blocks 82, 60 and 74 can be used to resolve datatype incompatibilities.
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7 Basic structure of the C Code

When setting up a new project with X2C code generation it is necessary to configure the
hardware on the target system. The following section provides basic information how the
Blinky demo applications are structured. With this understanding one should be able to adapt
hardware configuration for further projects.
In the following the Blinky demo application in combination with the TI Piccolo F28069
ControlSTICK and the TMS320F28069 Processor is used for demonstration.
Info: The *.c files listed below need to be updated in case of changes in the Xcos model
configuration.

7.1 Main.c

• initInterruptVector() defined in Hardware.c configures the target specific interrupts.

• initSerial() defined in Hardware.c initializes the serial interface.

• initHardware() defined in Hardware.c here the peripheral devices such as Watchdog,
GPIO Ports, ADCs, Timers and others are defined.

• X2C_init() defined in X2C.c calls the initialization functions of the X2C blocks.

• The while(1) loop is mainly used for the serial communication.

• The mainTask() function is the key structure of the project. Here the connection
between Outports and Inports are defined and the X2C_Update() function (defined in
X2C.c) is called. The basic structure of the mainTask() is

1. Assign Inports

2. Call X2C_Update()

3. Update Outports

The mainTask() function is usually called by an Interrupt Service Routine (Isr) which
can be triggered by multiple sources.
Example: In the Blinky Demo Application after each ADC conversion cycle the ADCIsr
calls the mainTask() function.

• KICK_DOG resets the Watchdog timer periodically. During operation this timer contin-
uously counts a certain time span (configured in Hardware.c). If the application has
an unexpected failure KICK_DOG can not be called and the Watchdog timer exceeds
its limit and therefore the target reboots. If the operation executes as expected the
Watchdog timer is within the limit and can be reseted by KICK_DOG without any further
actions.

7.2 Hardware.c

In this file all connections and peripheral device settings should be made.

• In initHardware() all peripheral function should be initialized.

– Watchdog timer

– GPIO Ports

– Interrupt initialization

– ADC, Timer, PWM and all the other peripheral devices

• initSerial() initializes the serial interface on the target. The settings made here should
match with the setting made in the Communicator described in Section 11.
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8 Testing

8.1 JUnit tests

To minimize the risk of software bugs most parts of X2C are tested. The Java core of X2C is
tested wit JUnit tests.

8.2 CUnit tests

Much care is also taken of testing the C-code of the blocks. These so called CUnit tests are
conducted directly on the target. In Figure 8 the test setting can be seen.

Figure 8: CUnit test setting

In the test environment on the PC a input vector and a parameter vector, if necessary, are
defined and sent to the target via serial interface. On the target the update function of the
block under test is executed. The resulting output vector is transferred back to the PC where
it is compared with a reference output vector. If the difference between the actual and the
reference output vector is below a specified limit the test is marked as passed. Otherwise an
error is reported.
Basically, the generation of the test vectors are done with one or a combination of these
methods:

Equivalence class testing To reduce the number of test items they are grouped into classes
with same behavior. Only one member of each equivalence class is used as entry
for the test vector. Two simple equivalence classes could be positive and negative
numbers.

Boundary testing The entries for the test vectors are chosen in such a way that they lie
below and above critical boundaries. For example, typical values for a FiP16 imple-
mentation would be -32768, -32767, -1, 0, 1, 32767.

Back-to-back testing For complex blocks this method is used. The vectors are generated
by simulating a block or model with the same functionality in Simulink or Xcos.

Several different targets are used for testing. The test reports can be found in the library
documentation Library.source.pdf in the directory <X2C_ROOT>\Library.
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9 Coding Conventions

9.1 Language

The native language of X2C is English. Hence all documentation, file names, variables,
comments in source files, etc. should be in English.

9.2 General naming conventions

• Unless otherwise stated, all names should use the camel case notation. A definition
of camel case can be found on http://en.wikipedia.org/wiki/CamelCase. The type of
camel case (upper or lower) depends on the type of name, see sections below.

Examples: ThisIsUpperCamelCasing.java, showLowerCamelCaseExample()

• Non-ASCII characters should be avoided. Also the space character schould not be
used.

• Due to a character limitation in Scilab, names with more than 27 characters should be
avoided.

• Names should not start with a number.

• Hungarian notation should not be used.

9.3 Naming of files

In general files should have a meaningful name. If abbreviations are used, easy understand-
able ones should be used. Upper camel case is recommended.
Examples: Hardware.c, SystemControl.c, GlobalDefines.h

9.4 Naming of functions and methods

Function and method names should contain a verb to describe the action of the function.
The verb is placed first and is in lower case and subsequent nouns start with a capital letter
(lower camel case).
Examples: readADC(), setPWM()

9.5 Naming of macros

Macros should be written in capital letters. Macro names which contain mutiple words should
use a underscore as seperator (screaming snake case).
Examples: DISABLE_PWM, NO_ERROR

9.6 Naming of variables

Based on the proposed convention from Sun Microsystems following guidelines should be
considered:
Variables are in mixed case with a lowercase first letter. Internal words start with capital
letters. Variable names should be short yet meaningful. The choice of a variable name
should be mnemonic- that is, designed to indicate to the casual observer the intent of its
use. One-character variable names should be avoided except for temporary "throwaway"
variables. Common names for temporary variables are i, j, k, m, and n for integers; c, d, and
e for characters.
Examples: int16 i; float32 myWidth;
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9.7 Naming of model parameters

Parameter and variable names in Matlab or Scilab should follow lower snake case notation.
This means the first word can either start with a lower or upper case letter, all subsequent
words have to start with a lower case letter, and the words are seperated by underscores.
Examples: i_ref, n_max, k_T, U_dc_max

9.8 Naming of X2C blocks

Block and Subsystem/Superblock names in Matlab or Scilab should follow upper camel case
notation. Exceptions are words with abbreviations, then a underscore character as seperator
is allowed to increase readability.
Examples: CurrentController, OffsetAngle, AnIn1, DigOut1, I_Phase1

9.9 Source and header files

Every *.c source file should have a corresponding *.h header file. A minimalistic header with
prototype definitions is sufficient.
Due to MISRA rule 8.1 (see MISRA-C 2004 compliance) it is required to have prototypes for
every function, including static ones. To avoid conflicts between global and static function
prototypes when including header files, the following rule shall apply:

• Global function prototypes should be located in its header file

• Static function prototypes should be located at the beginning of its source file

9.10 Global definitions

Definition of macros which are used in more than one source file should be placed in
GlobalDefines.h. Macros only used in one file should be defined in the source file in which
they are used.
Globally needed variables should be defined in GlobalDefines.c and declared in
GlobalDefines.h. This way all global variables are at one place and can be referenced from
every file which has the GlobalDefines.h header file included.
Example:

Listing 1: GlobalDefines.c
1 #include "GlobalDefines.h"

2

3 /* *************************************************************************** */

4 /* Global Variables */

5 /* *************************************************************************** */

6 uint16 errorstate = NO_ERROR; /* Error Message */

7 uint32 modulestate = NO_ERROR; /* Module Status */

8 FIStates FIState = RESET_STATE; /* State of frequency inverter */

Listing 2: GlobalDefines.h
1 #ifndef GLOBALDEFINES_H

2 #define GLOBALDEFINES_H

3

4 #include "Target.h"

5 #include "X2C.h"

6

7 /* *********************************************************************** */

8 /* Global Variables */

9 /* *********************************************************************** */

10 extern uint16 errorstate; /* Error Message */

11 extern uint32 modulestate; /* Module Status */

12 extern FIStates FIState; /* State of frequency inverter */

13

14 #endif
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9.11 Template files

For an easy orientation standard file names should be used in X2C projects:

• Main.c: Frame program main file.

• Hardware.c: Hardware configuration and initialization.

• GlobalDefines.*: Files with globally needed definitions and variables.

• SystemControl.c: File with startup sequence of power electronics and error handling.

• InterruptControl.c Interrupt handling, especially interrupt vector table and interrupt
service routines.

• InputControl.c: Handling of analog and digital inputs.

• OutputControl.c: Handling of analog and digital outputs.

• CANControl.c: Configuration, initialization and functions of a CAN interface.

Of course, if files contain a lot of code it is recommended to split the file into several ones to
maintain comprehensibility.
Example: Splitting of InputsControl.c in AnalogInputControl.c,
DigitalInputControl.c and HallSensorControl.c

9.12 Include order of header files

To avoid conflicts and missing dependencies header files should be included in following
order:

1. System headers

2. Application headers

3. Header of current source file

Example:

Listing 3: Main.c
1 #include "VersionInfo.h"

2 #include "GlobalDefines.h"

3 #include "Hardware.h"

4 #include "SystemControl.h"

5 #include "InputControl.h"

6 #include "OutputControl.h"

7 #include "Main.h"

9.13 Hardware registers

To maintain comprehensibility and to allow interchangeability of source files hardware (DSP)
registers should be accessed via macros.
Example:

#define SET_LED (GPBSET = 0x00000004)

/* some code */

SET_LED;

/* some more code */

instead of
/* some code */

GPBSET = 0x00000004;

/* some more code */
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10 MISRA-C 2004 compliance

The rules of the Motor Industry Software Reliability Association MISRA should be followed as
much as possible. Some major rules are:

• MISRA-C:2004 2.2/R: Source code shall only use /* ... */ style comments.

• MISRA-C:2004 19.4/R: C macros shall only expand to a braced initialiser, a constant,
a string literal, a parenthesised expression, a type qualifier, a storage class specifier, or
a do-while-zero construct.

• MISRA-C:2004 8.12/R: When an array is declared with external linkage, its size shall
be stated explicitly or defined implicitly by initialisation.

• MISRA-C:2004 18.4/R: Unions shall not be used.

• MISRA-C:2004 16.3/R: Identifiers shall be given for all of the parameters in a function
prototype declaration.

• MISRA-C:2004 19.15/R: Precautions shall be taken in order to prevent the contents of
a header file being included twice.

• MISRA-C:2004 19.1/A: #include statements in a file should only be preceded by other
preprocessor directives or comments.

• MISRA-C:2004 8.1/R: Functions shall have prototype declarations and the prototype
shall be visible at both the function definition and call.

10.1 Applied rules

1 /* Enable MISRA -C:2004 checking (all rules) */

2 --check_misra="all"

3

4 /* Rule violation handling */

5 --misra_advisory="warning"

6 --misra_required="warning"

7

8 /* Exceptions */

9 --check_misra=" -1.1" /* (MISRA -C:2004 1.1/R) Ensure strict ANSI C mode (-ps)

is enabled */

10 --check_misra=" -12.7" /* (MISRA -C:2004 12.7/R) Bitwise operators shall not be

applied to operands whose underlying type is signed */

11 --check_misra=" -19.7" /* (MISRA -C:2004 19.7/A) A function should be used in

preference to a function -like macro */

12 --check_misra=" -5.7" /* (MISRA -C:2004 5.7/A) No identifier name should be

reused */

Listing 4: MISRA.opt
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Part III

Utilities

11 Communicator

The Communicator is the interface between the target system and the model in Xcos . It is
used to generate the C code files out of the model. Furthermore it is used to transfer data
between the computer and the target. When started the Communicator is connected with the
model via RMI interface and via serial interface with the target (DSP).

11.1 Xcos Communicator start

As described in Section 16 the Communicator is started out of an open Xcos model with
the buttons start Communicator. The button Transform model and push to Communicator
loads the model file (.xml) into the Communicator. Changes in the model structure can be
made and pushed to the Communicator by double clicking on the button Transform model
and push to Communicator.

11.2 Standalone Communicator start

If there are no intended changes in the model structure it is possible to start the Communicator
without Xcos . In <X2C_ROOT>\System\Java double click on Communicator.jar. In the
open Communicator go to Model → Load Model and browse to your project directory. In the
X2CCode folder choose the model (.xml) file and open it. In the Status tab check the Log
area if the model has been loaded successfully.

11.3 Basic functions of the Communicator

The Communicator is structured into the menu bar (1) the toolbar (2) and four main tabs (3).
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Figure 9: Basic structure of the Communicator

1. Menu bar

• In the File menu the settings can be modified, loaded and saved.

• In the Model menu a new .xml file can be loaded and saved.

2. Toolbar

• With the button Connect to Target the Communicator can be connected respec-
tively disconnected from the target.

• Create Code generates the X2C C code files out of the X2C model.
Changes in the Model tab like Sample time require new code creation.

• Create RTOS Code was moved to Settings. See 11.4 for details.

• In the Download settings the Binary and MAP files can be selected. These files
are usually generated during the build process and are used by the Communicator
for the following purposes:

(a) The binary is required to download an application to the target system. This
feature is not available in the free edition.

(b) The MAP file is optional and is required only to view global variables in the
X2C Scope. See 12 for details.

• The Download application to target function is only available in the Professional
edition of X2C . This function provides application download functionality without
any use of external programing devices.

• The Scope button starts an oscilloscope like environment for plotting signals and
variables of the running target. For more information see Section 12.

3. Tabs

• In the Status tab there are two main areas as seen in Figure 10. In DSP state the
current status of the connected target is shown. The following states are possible:
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– The Bootloader state indicates that no valid/working application is present
on the target system. Bootloader and Application download are avilable in
the Professional edition only.

– The Program loaded state indicates an application is present and running.

– In the Idle state only the communication between target and computer is
active. All controller functions are inactive furthermore the Outports values
are static.

– The Init state calls the initialization functions of all X2C blocks. In this state
all signals an variables are reset to their initial values.

– Run - Power off means the application is running normally but the power
supply of the power electronics (e.g. frequency converter) is off.

– In Run - Power on the system is fully active.

Info: In the Blinky demo application the last four states cannot be changed
because they are only useful for engine control applications.
The Log area shows status updates and error messages and can be cleared with
the Clear button.

Figure 10: Communicator status

• The Setup tab is for the interface configuration. To change the settings the
Communicator needs to be disconnected from the target.
There are a few ways to connect with the target. One can choose between Serial,
USB and PCAN interface. The setting made here need to be compatible with the
target configurations.
In the Protocol area the LNet Node ID can be set. By default this value is set to 1.
Since the Communicator can be used with more than one target each target is
defined with an unique LNet Node ID.
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Figure 11: Communicator setup

• In the Model tab the Model structure area provides a list of the used blocks in the
Scilab model. Jump to Section 11.5 to see how variables can be changed through
the Model structure settings.
The Model properties settings need to be made before code generation.

– The Sample time can be changed in the Xcos model by changing the values
in the CLOCK block. After double clicking on transform model and push
to Communicator the sample time in the Communicator is updated. After
clicking on Analyze the sample in the Communicator is updated.
Note: Changes of the sample time made in the model need to be compatible
with the defined sample time on the target.

– Use Scope was moved to Settings. See 11.4 for details.

– Use Parameter ID for block data transfer was moved to Settings. See 11.4
for details.
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Figure 12: Communicator Model

11.4 Settings

The Settings can be found in the File menu. The Settings view is divided into 4 tabs.

Figure 13: Communicator Settings

Common

• Use Scope [enabled]
Use Scope defines if the scope application (see Section 12) can be used when
connected with the target. When disabled the target processor is relieved due to less
communication effort.
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• Create RTOS code [disabled]
Generates code which is optimized for real time operations.

• Connect to target on startup [enabled]
Tries to connect to the target when the Communicator starts. If this option is enabled,
the previously used communication setup is being used.

Advanced

• Create Signals code [disabled]
Creates a file containing lists with internal X2C signals. These signals are Inports,
Outports and Block Outports.

• Create & compile HotInt code [disabled]
Generates HotInt specific files. After successful generation, the HotInt project (Mi-
crosoft®Visual Studio) is being compiled. The latest version being found is used for
compilation. Supported Visual Studio versions:

– Visual Studio 2013

– Visual Studio 2012

• Enable Code For Speed Optimizer [disabled]
Allows the usage of the Code For Speed Optimizer. Refer to 14 for details.

External

Allows to select executables which are executed

• before code generation (Pre-Generate)

• after code geneeration (Post-Generate)

B&R AS Connector

This tab allows to configure the X2C Connector for B&R Automation Studio . Refer to 21 for
details.

11.5 Change parameters on the target with the Communicator

If all connection are set up properly there are two ways of changing the parameter values on
the running target.

1. In the Communicator click on Model. In the Model structure area all the Block properties
are listed and can be changed by double clicking on them.

2. In the Xcos model double click on the blocks and change the values.
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12 Scope

The Scope application is a very useful device for monitoring signals and variables on the
running target. It allows an easy observation in an oscilloscope like environment. The Scope
is structured into four main areas as seen in Figure 14.

Figure 14: Communicator Scope

1. The Plot area shows the selected values at a time based abscissa (x-coordinate) in
milliseconds and scaled from −1.0 to 1.0 at the ordinate (y-coordinate). Furthermore
there is a legend a the bottom of the plot area showing the color of each channel.

2. In the Sample/Timing Info section options of the time axis can be made. The oscil-
loscope is started with the button SAMPLE. When the option Single-shot is marked
only one time period (see Total time) is shown in the plot area. When unmarked the
plot area continuously plots the received values from the target. Due to time delay in
data transfer it is possible that there a missing values between two plot cycles.
The plot process can be stopped with the button ABORT.
With the option Sample time factor the time axis can be scaled. Factor 1 means every
value (Time between two values is Sample Time) is plotted in the plot area. As example
factor 5 means every fifth value is used, therefore a longer time span can be plotted at
the time axis.

3. The Channel Configuration configures which signal is shown at the plot area. There
are eight channels that can be plotted simultaneously. Mark Enable to configure one
channel. In the Type menu Address, Block Port and I/O port can be chosen. I/O ports
are the links between the target peripheries and the X2C model. The Block Port are
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signals used in the X2C model.
When fixed point data representation is selected all signal are scaled to values between
−1.0 and 1.0, therefore one might use the option Gain or Offset to plot the signal in
real scale.

4. The Trigger Configuration is divided in the options NORMAL and AUTO. When
option AUTO is chosen no specific trigger is set. In this configuration signal values
are continuously transfer and plotted. This can lead to moving graphs especially when
periodic signals are observed.

Choose NORMAL to set up a trigger.

(a) In Source Config choose a signal which should work as trigger source.

(b) With Edge the trigger only checks rising respectively falling edges of the source
signal.

(c) The Level and Delay options move the trigger point in vertical and time direction.

Example: Trigger the harmonic sine wave u from a SinGen block.
As trigger source the signal itself is used. When the trigger is delayed in time a vertical
marker indicates the position. The effect of the settings Level with a value of 0.2 and
Edge for FALLING can be seen in Figure 15.

Figure 15: Scope Trigger using Example
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13 Block Generator

The Block Generator is used to create new blocks, load and/or edit previously saved blocks.
The following, essential parameters define the block function:

13.1 Block properties

Name

Each block within a library must have a unique name.

Library type

The library type selection is done via the ’Change configuration’ button.
An internal library block will be stored within the X2C structure where only the library name is
required. The internal library name can be selected via a dropdown menu.
When the block is saved, the files will be automatically saved into the correct directories.
An external (or project specific) block is stored within its project structure and requires
the user to enter a library name and pre-namespace identifier. Both, the library name &
pre-namespace, is enterd via text fields.
When the block is saved, a window will appear, which allows to select the project directory for
this project specific block (only directory selection is possible) The Block Generator tries to
save the files in the following structure (directories will be created automatically if they don’t
exist):
<selected directory>\Library\<library name>\

Figure 16: Block Generator External library settings

Identifier

Every block needs an unique identifier (ID) across all libraries to ensure proper functionality if
a project uses blocks from different libraries. ID should be a value < 4000 for internal blocks
and a value ≥ 4000 for external blocks.

Additional LATEX information file

In case of having a LATEX file with additional block information the name of the file can be set.

Mask In- & Outports

Every block can have several inports & outports. Each in-/outport must have an unique name.
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Figure 17: Block Generator Mask Inport

Mask Parameters

Every block can have several mask parameters. Each mask parameter must have an unique
name. Prompt will be displayed next to the value input of this parameter. Data type decides
between an input field for type Double or a dropdown menu for type ComboBox.
In case of type Double you can select the Default value for this parameter.
Type ComboBox lets you add/remove items which can be selected by the user if this pa-
rameter value should be changed. The default value is defined by selecting one out of the
entries.
Visible makes this parameter visible, Changeable en- or disables this parameter.

Figure 18: Block Generator Mask Parameter

Visualizations

Visualizations are used to represent the block within a model. Command contains the
language specific commands to represent the block.

32



13.2 Implementation properties

Every block must have at least 1 Implementation. Each Implementation has its Init-, Update-,
Save- and Load functions (C) and Conversion functions (Java/Python/JavaScript).

Name

Each implementation must have a unique name within a block. The Implementation name is
used for C- & Java code file name.

Identifier

Every Implementation needs an unique idendifier (ID) within its block. This ID can have
values in the range from 0 to 15.

Controller In- & Outports

The Controller In- & Outport names can be selected but not edited. The names are defined
by the block’s Mask In- & Outports. Only the data type must be selected for each In-/Outport.

Controller Parameter

Each Controller Parameter must have an unique name within its Implementation. The data
type and default value can be selected. Also the ability to download/upload the parameter
can be defined by using Load & Save Enable checkbox.
The Array option allows the Parameter to contain a data array instead of a scalar value. Two
array configurations are possible:

• Modifyable
Enabled by setting the Array checkbox and Array size. This type of array has a fixed
size and is located in volatile memory. Due to volatile nature the data can be up- and
downloaded.

• Fixed
Enabled by setting both, the Array and Array in flash memory checkboxes. The size of
this type of array is not fixed because it is generated on Model generation. It is located
in non-volatile memory and therefore cannot be up- and downloaded.

Figure 19: Block Generator Controller Parameter
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Conversion function type

The Conversion function type can be selected by using the dropdown menu. If Java, Python
or JavaScript is selected, the Block Generator will generate a conversion function template
file for this block which needs to be manually filled with block-specific conversion calculations,
otherwise no conversion function file will be created.

13.2.1 Advanced Implementation Settings

Figure 20: Block Generator Advanced Implementation Settings

Function Link

If this option is enabled, the Init-, Update-, Load- and Save Block functions are used from an
other Block Implementation. A Block within the same X2C library may be selected as link
source.

Update Function

This option is enabled by default. If disabled, the Implementation does not have a (cyclic)
Update function.

Allow empty Load function

Forces the Block Generator to create a Load function even if the Implementation doesn’t
contain any transmittable parameters. The user customizable part of the Load function may
be used to change the Load functions’ default behaviour.

13.3 Save or load a block

Saving & loading is done via the File menu in the menu bar.

34



Saving

If the selected block is member of an internal library, the Block Generator automatically uses
the correct library root directory.
In case of an external library block type, the user is prompted a directory selection window, in
which the project directory can be selected. The library root directory is now located in:
<user directory selection>\<Library>\<library name>.
Each library is organized in this structure:

• Controller: Directory with the C-code source files (*.c, *.h).

• Conversion: Directory with the Java, Python or JavaScript conversion files.

• Doc: Directory with files needed for the (auto-generated) documentation.

• Scilab: This directory contains the Xcos library files as well as the interfaces functions
and the files need for simulation in Xcos .

• XML: Configuration files (*.xml) contain all block parameters and are located in this
directory.
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Part IV

Add-Ons

14 Code For Speed Optimizer (CFSO)

The CFSO allows the optimization of the X2C Update function(s) to decrease the execution
time. TO achieve this, the CFSO, if activated, replaces the X2C Block function calls by the
X2C Block Update code itself to remove the overhead of C function calls. The optimizer
collects the required information from the Block-Implementation C source code.
It can be enabled in the Advanced Communicator settings tab.

Figure 21: CFSO in Advanced Communicator settings

This feature is only available in editions Plus and Professional.

14.1 Data Collection

The CFSO collects the data from the C source for each Block-Implementation type. If the
source is not available, the Implementation is tagged to use the usual Update function call in-
stead and the next Implementation type is processed. Otherwise the following Implementation
specific elements are extraced from the C source:

• Preprocessor code

• Includes

• Define names

• Update function code

During data extraction, every occurence of the Implementation Pointer variable is replaced
by a placeholder. The data collection procedure is repeated for every Implementation type in
the Model. In the further course the X2C Code Generator will replace the placeholder by the
current Block variable.
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14.1.1 Implementations using a function link

This kind of Implementation shares the Update function code with an other Implementation.
In this case the Preprocessor code, Includes and Define names from both Implementations
are merged. The Update function code is retrieved from the linked Implementation.

14.2 Code Generation

Once all the Implementation information is collected, the X2C Code Generator replaces every
Update function call, except for the Implementations of which the sources are not available.
Following elements are added at the beginning of the generated X2C C file:

• An informational line beyond the header to inform the user that the CFSO is active

• All collected Implementation C Includes

For each Update function the follwoing content is added in the following order:

1. Preprocessor code

2. Implementation Update function

3. Undefine C macros (#undef) for all possible defined C macros

The placeholders, which were set during the data collection procedure, are replaced by the
appropriate Block Implementation variable. In case of an Implementation with unavailable
C source, the usual Update function call is used. A comment is added above the relevant
Update function call for information.
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15 Dashboard

The Dashboard allows the user to view and modify selected elements. Each element features
various, configurable properties for a user friendly representation of each data value. The
elements can be uploaded or downloaded - depending on the respective type.
A download can be done for each indivdual, editable entry by changing its value or for all
editable values by using the ’Download Editable Values’ button.
The upload procedure is started by the ’Start Update’ button and uploads ALL uploadable
values at a defined interval.

Figure 22: Communicator Dashboard View

This feature is only available in editions Plus and Professional.

15.1 Configuration File

The Dashboard configuration is stored in a properties file. Currently there is no GUI support
to setup a Dashboard configuration. Instead, the user has to setup the file.
Configuration file templates are available to make the configuration process easier. These
templates can be found in directory /Templates/Dashboard.

A Dashboard configuration can be loaded or cleared via the Communicator menus. Two
options are available to either load a new configuration or clear the current configuration.
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Figure 23: Communicator Dashboard configuration

These elements are usually contained in a configuration file:

Property

A property is defined by a key and value. The syntax is
KEY=VALUE

Example:
MODEL=MyModel.xml

Comment

The hash symbol # introduces a comment line. Every line starting with a hash symbol is
ignored by the configuration file parser. Example:
# This line is a comment

15.2 Common properties

Each Dashboard element does have common properties independent of its type.

Alias name

If this property is set, the alias name will be displayed instead of the element name. Otherwise
the element name is shown.

Property name: ALIAS

Example:
ALIAS=Show this text instead
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Offset & Gain

Applies Offset and Gain factors. This allows, for example, the transformation between
physical unit and raw value. If one or both values are not set, the appropriate default value is
used. The default for GAIN is 1.0, the default for OFFSET is 0.0.

Property name: OFFSET, GAIN

Example:
OFFSET=0.5

GAIN=2.0

ATTENTION:
The Offset and Gain calculation depends on the transfer direction (UPLOAD or DOWNLOAD).

DOWNLOAD (data is transferred from Dashboard to the target):
TargetV alue = DashboardV alue ∗GAIN +OFFSET

UPLOAD (data is transferred from the target to the Dashboard):
DashboardV alue = (TargetV alue−OFFSET )/GAIN

Unit

Defines a physical unit. If this property is not set, no unit will be used.

Property name: UNIT

Example:
UNIT=MyUnitName

15.3 Element types

15.3.1 Block-Parameter

Allows to define an X2C Block and one of its Mask Parameters to be downloaded to the
target. Following additional properties have to be set to identify the selected X2C Block:

• BLOCK
X2C Block name

• PARAMETER
Mask Parameter name of X2C Block

• MIN
Defines the lower limit for the value
If this value is not defined or empty, no lower limit is active.

• MAX
Defines the upper limit for the value
If this value is not defined or empty, no upper limit is active.

• VALUE
Sets the initial Dashboard value
If this value is not defined, the current Mask Parameter from the Block is used
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This element type can currently be used for download only.

A complete example for a Block-Parameter element. This first 5 properties are Block-
Parameter-type specific, the rest are common properties.
BLOCK=MyConstant

PARAMETER=Value

VALUE=5.0

MIN=1.0

MAX=12.0

ALIAS=Voltage

UNIT=V

GAIN=300.0

OFFSET=10.0

15.3.2 Variables

Allows to define a global symbol (variable) to be uploaded from the target and displayed in
the Dashboard. Following additional properties have to be set:

• VARIABLE
Variable name

• TYPE
Data type of the variable

The data type can be one out of the following values:
int8, uint8, int16, uint16, int32, uint32, int64, uint64
The Boolean type is currently not supported. This element type can currently be used for
upload only.

ATTENTION:
This feature requires a MAP file to be loaded in the Communicator because the target
memory addresses for each global variable is extracted from the MAP file generated
by the vendors’ toolchain. If no MAP file is loaded, the variables will be displayed in
the Dashboard View but the ’Start Update’ button will remain inactive. If one or more
invalid variable names are encountered in the Dashboard configuration file, an error
message is shown in the Communicator log for every invalid variable name. Trying to use
the ’Start Update’ button will result in an error message showing the first invalid variable name.

A complete example for a Variable element. The first 2 properties are Variable-type specific,
the rest are common properties.
VARIABLE=MyGlobalVar

TYPE=int16

ALIAS=Current

UNIT=A

GAIN=100.0

OFFSET=0.0
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15.4 Model Override

This property allows the Communicator to replace the currently loaded X2C Model or load a
new Model at all. The property is optional and can be omitted if not used but must be defined
at the beginning of the Dashboard configuration file if used. The value can be a filename or a
fully qualified file name containing the complete path.

Property name: MODEL
Example:
MODEL=MyModelFile.xml

MODEL=C:\MyProject\Dashboard.txt

The Communicator log window displays a message if loading the Model from the configuration
file was successful.

Figure 24: Communicator Dashboard Model log entry
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Part V

How-To

16 X2C® code generation with Scilab

The following section describes X2C code generation of a Xcos model based on the Blinky
demo application.

1. Open Scilab and in the file browser navigate to your project directory
(e.g. <X2C_ROOT>\DemoApplication\Blinky_TI_TMS320F28069_controlSTICK\
X2CCode).

2. Double click on DemoApplication.zcos. The example project contains a few blocks
used to demonstrate the basic function of X2C (see Figure 25). The Inport and Outport
blocks define the interface between the generated X2C code and the peripheral
functions (e.g. ADC or GPIO Pins) on the target. For details about each block function
read X2Copen.Doc.pdf in the documentation folder of the X2C directory.

Figure 25: Blinky demo application in Scilab

3. Double click on start Communicator (for more information about the Communicator
see Section 11). Some details of the current actions of the Communicator are shown
in the Log area of the Communicator window and the Scilab command line:

1 Starting Communicator

2 done

3 Successfully connected to Communicator

4. Double click on Transform model and push to Communicator and check the pop-up
window for the end of the transformation process.
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5. Click Create Code in the Communicator. Now the files X2C.h and X2C.c are generated
in the <PROJECT_ROOT>\X2CCode directory and the Log screen should contain the
lines:

1 [...]

2 Model updated

3 Model XML file write: OK

4 Create code successful.

6. The C code for the X2C application has been created. Depending on the used target
start the programming tool (e.g. Code Composer Studio , µVision or MPLAB X )
and import the Blinky demo application project as described in Section 17, or 18
respectively. Follow the instructions on how to configure and download the application
to the target.
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17 Loading and building the demo application Blinky in Code
Composer Studio

The demo application Blinky is intended to be used with a TI F28069 Piccolo controlSTICK.

1. Connect the TI F28069 Piccolo controlSTICK to the computer.

2. Open Code Composer Studio (choose workspace directory as you like). Now click
Project → Import Existing CCS Eclipse Project. Browse to the location of the Blinky
project (<X2C_ROOT>\DemoApplication\Blinky_TI_TMS320F28069_controlSTICK).
Click Finish to import the project.

3. In the Code Composer Studio file structure of the Blinky demo project there are two
virtual folders Blocks and Core, which should be linked directly to the X2C directory.
To ensure this go to Project → Properties drop down Resource and click Linked
Resources. Double click on folder X2C_ROOT and set the correct link to your X2C
installation directory (<X2C_ROOT>). After hitting OK two times there should not be
any warning signs (like shown in Figure 26) at the icons for the linked files in the Blocks
and Core folders.

Figure 26: Code Composer Studio invalid (left) and valid (right) X2C root directory

4. The generated code from X2C is located in the folder <X2C_ROOT>\DemoApplication\
Blinky_TI_TMS320F28069_controlSTICK\X2CCode. To check if code generation went
fine go to the X2CCode folder and open X2C.c. Make sure time and date of code
generation is plausible.

5. Build the project in Code Composer Studio by clicking Project → Build all or by
clicking on the Hammer symbol as seen in Figure 27 at the top of the screen. Check
for errors while building in the console at the bottom of the screen.

Figure 27: Code Composer Studio build and debug buttons

6. If your target is connected to the computer click Run → Debug or click on the Bug
symbol as seen in Figure 27 at the top. The program is now transferred to the target
and can be started with the green arrow button at the top.

7. After starting the program the on-board LED of the TI F28069 Piccolo controlSTICK
should be blinking!
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18 Loading and building the demo application Blinky in MPLAB®

X

The demo application Blinky is build for the combination of the Microstick II with the
dsPIC33FJ128MC802 processor and the MicrostickPlus developer board (for details see
www.microstick.com).
Info: To download a new application only the Microstick II needs to be connected with the
computer.

1. Connect the Microstick II with the computer.

2. Open MPLAB X and click File → Open Project. Browse to the location of the Blinky
demo application in the X2C directory <X2C_ROOT>\DemoApplication\. . .
\Blinky_Microchip_dsPIC33Fxxxx_MicrostickPlus. Click Open Project.

3. In the case the demo application is copied/moved to a different location, the include
paths have to be adapted. To ensure the compiler uses the correct path variables right
click on the Projectname → Properties → XC16 Global Options → xc16-gcc. In the
drop down menu Option categories choose Preprocessing and messages. Click
on the dots beside C include dirs. There are relative paths to the needed include files
listed as seen in Figure 28. Correct the links by double clicking on the path variables.
Info: Only the links to the Library and Controller path need to be updated.

Figure 28: Default path variables for the include files

4. Go to Run → Clean and Build Main Project or click the hammer with brush button as
seen in Figure 29. After building there should be a message BUILD SUCCESSFUL in the
message area at the bottom of the screen.

Figure 29: MPLAB X Clean and Build Main Project button

5. If the build process was successful go to Run → Run Main Project or click the Green
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Arrow button as seen in Figure 29. If there is a message similar to MICROSTICK not
Found try to select the Starter Kits (PKOB) item which represents your board.

6. After starting the program the LED (RB12) on the MicrostickPlus Board should be
blinking!
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19 Loading and building the demo application Blinky in µVision®

The demo application Blinky is intended to be used with the ST STM32F051R8 Discovery or
the ST STM32F072RB Nucleo kit.

1. Connect the ST development kit with the computer. You may have to install the ST-Link
USB driver (available on www.stm.com) to get the board recognized by your operating
system.

2. Open µVision and click Project → Open Project. Browse to the location of the Blinky
project (either <X2C_ROOT>\DemoApplication\Blinky_ST_STM32F051R8_Discovery
or <X2C_ROOT>\DemoApplication\Blinky_ST_STM32F072RB_Nucleo). Click Open to
import the project.

3. In the µVision file structure of the Blinky demo project are two virtual folders Blocks
and Core, which are linked relatively to the X2C directory. If the Blinky demo project is
copied/moved to a different location, the include paths as seen in Figure 30 have to be
adapted.

Figure 30: µVision include paths setting

To open shown window go to Project → Options for target ’Blinky Demo’ change to
tab C/C++ and click ... next to the include paths text field.

4. The generated code from X2C is located in the X2CCode folder (eg. <X2C_ROOT>\
DemoApplication\Blinky_ST_STM32F072RB_Nucleo\X2CCode). To check if code gen-
eration went fine go to the X2CCode folder and open X2C.c. Make sure time and date
of code generation are plausible.

5. Build the project in Code Composer Studio by clicking Project → Build target or by
clicking on the Build symbol as seen in Figure 31 at the top left of the µVision screen.
Check for errors while building in the console at the bottom of the screen.

Figure 31: µVision build and load buttons

6. If your target is connected to the computer click Flash → Download or click on the
Download symbol as seen in Figure 31 at the top left of the µVision screen. The
program is now transferred to the target and is automatically started.
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7. After starting the program the green on-board LED of the ST development kit should
be blinking!

8. To use X2C Communicator and Scope the computer has to be connected via serial
interface to the development kit. Early versions of the ST STM32F051R8 Discovery kit
do not support virtual COM port over USB. In this case a TTL-level compatible RS-232
adapter has to be connected to pin PA9 - TxD, PA10 - RxD and GND.
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20 The creation of an external project-specific X2C® block

The creation of an external project-specific X2C block is summarized in three steps by the
subsequent three subsections.

20.1 The creation of the basic structure

The first step in the creation of an external project-specific X2C block is the creation of
its basic structure using X2C Block Generator previously described in Section 13. X2C
Block Generator can be initiated by executing the BlockGenerator.jar file located in
<X2CRoot>\System\Java\. Once executed, X2C Block Generator opens up in the form of
the GUI shown in Figure 32 whose options are described hereafter.

Figure 32: The initial appearance of the X2C Block Generator GUI

Block Parameters

• Name of the block needs to be uniquely specified for the unambiguous identification of
the block in the library and the Simulink or Scilab Xcos model.

• Prompt is displayed in the help of the block in Scilab Xcos.

• Description of the block is displayed in the dialog window of the block in both Simulink
and Scilab Xcos and should describe the purpose of the block.

• License can be selected from the drop-down menu that contains various options or it
can be manually defined by clicking on the Edit push-button.

• Library needs to be specified by clicking on the Change Configuration push-button
that opens up the Library Configuration window in which the External radio-button
should be selected. By doing so, the Library Name and Pre-Namespace text-fields
become available. It is mandatory to save the library in the <ProjectRoot> folder (i.e.
the folder that contains the X2CCode folder).
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– Library Name should be uniquely specified.

– Pre-Namespace is used for Java conversion functions and can be arbitrarily
selected. For example the library name can be entered here as well.

• ID needs to be an unique integer number between 4000 and 8191, including those two
limits.

• Author of the block should be specified.

• Revision should be specified to enable the distinction between different software
versions of the block.

• TEX File containing a description of the block in the LATEX format that can be optionally
created for the documentation of the block. When writing display math, it is advisable
not to use environments provided by the amsmath package. Instead, displaymath,
equation, array, and eqnarray should be used for consistent rendering of display
equations by JLATEX in the generated .html file. The name of the .tex file should differ
from the name of the block. (Internal convention is <BlockName>_Info.tex).

• Date Created is automatically specified upon the creation of the block.

• Date Changed is automatically specified every time the block is changed.

• Mask Inports are user interfaces that need to be defined for all inputs of the block by
clicking on the Add push-button that opens up the Mask Inport window in which the
Name and Description text-fields under the Parameters section become available.
Every mask inport can also be removed or edited by clicking on the Remove or Modify
push-button, respectively.

– Parameters

* Name is displayed in the documentation of the block.

* Description is displayed in the documentation of the block.

• Mask Outports are user interfaces that need to be defined for all outputs of the block
by clicking on the Add push-button that opens up the Mask Outport window in which
the Name and Description text-fields under the Parameters section become available.
Every mask outport can also be removed or edited by clicking on the Remove or
Modify push-button, respectively.

– Parameters

* Name is displayed in the documentation of the block.

* Description is displayed in the documentation of the block.

• Mask Parameters are user interfaces that need to be defined for all parameters of
the block by clicking on the Add push-button that opens up the Mask Parameter
window in which the Name, Prompt, and Description text-fields together with the
Data Type drop-down menu under the Parameters section become available. Every
mask parameter can also be removed or edited by clicking on the Remove or Modify
push-button, respectively.

– Parameters

* Name is displayed in the documentation of the block.

* Prompt is displayed in the dialog window of the block in both Simulink and
Scilab Xcos.

* Description is displayed in the documentation of the block and the dialog
window of the block in both Simulink and Scilab Xcos.
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* Data Type can be selected from the drop-down menu to be either Double or
ComboBox as well as Visible and/or Changeable by the available check-
boxes.

– Data Type Parameters

* Default value of the parameter needs to be specified in the case of Data
Type: Double.

* Add or Remove push-buttons become available for adding items in the case
of Data Type: ComboBox.

• Visualizations of the block can be separately defined for Simulink by clicking on the
Add Matlab push-button as well as for Scilab Xcos by clicking on the Add ScilabXcos
push-button.

– Visualization Parameters for Simulink

* Command can contain labels of the block and its input(s) and output(s) that
can be defined as:
disp('\fontsize12<BlockLabel>', 'texmode', 'on')

port_label('input', '<InputNumber>', '<InputLabel>',

'texmode', 'on')

port_label('output', '<OutputNumber>', '<OutputLabel>',

'texmode', 'on')

– Visualization Parameters for Scilab Xcos

* Define Section defines options of the block in the x2c_<BlockName>.sci

script between // ++ BlockGenerator: Define Section and // �

BlockGenerator: Define Section.

* Block Icon Default Size defines the size of the block in Scilab
Xcos units in the x2c_<BlockName>.sci script between // ++

BlockGenerator: BlockIconDefaultSize and // � BlockGenerator:

BlockIconDefaultSize.

* Plot Section defines options of the block in the x2c_<BlockName>.sci script
between // ++ BlockGenerator: Style and // � BlockGenerator:

Style.

* Style defines options of the block in the starter.sce script between //

++ BlockGenerator: Plot Section and // � BlockGenerator: Plot

Section.

• Direct Feedthrough should be generally checked. It should be unchecked when the
block serves as a breaker of an algebraic loop.

Implementations

• Current Implementation serves as an identifier of the current implementation and
can be arbitrarily named, whereby multiple implementations are possible. The internal
naming convention of LCM defines Bool (Boolean), FiP8 (8 Bit Fixed Point), FiP16 (16
Bit Fixed Point), FiP32 (32 Bit Fixed Point), Float32 (32 Bit Floating Point), and Float64
(64 Bit Floating Point) as implementations. A new implementation can be defined by
clicking on the Add push-button as well as removed by clicking on the Remove button.

• Default Implementation can be selected by choosing the desired implementation from
the Current Implementation drop-down menu (if multiple available) and clicking on
the Set Default push-button.
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Implementation Parameters

• Name is automatically taken from the Current Implementation drop-down menu and
every change in the text-field directly renames the selected implementation in the
Current Implementation drop-down menu. The internal naming convention of LCM
defines Bool, FiP8, FiP16, FiP32, Float32, and Float64 as names.

• Display Name of the current implementation is displayed in the dialog window of the
block in the Used Implementation drop-down menu. The internal naming convention
of LCM defines Boolean, 8 Bit Fixed Point, 16 Bit Fixed Point, 32 Bit Fixed Point,
32 Bit Floating Point, and 64 Bit Floating Point as display names. This name is used
for naming of the corresponding C and Java files.

• Description of the current implementation in the documentation of the block. The
internal naming convention of LCM defines Boolean Implementation, 8 Bit Fixed
Point Implementation, 16 Bit Fixed Point Implementation, 32 Bit Fixed Point
Implementation, 32 Bit Floating Point Implementation, or 64 Bit Floating Point
Implementation as descriptions.

• ID of the current implementation needs to be an integer number between 0 and 15,
including those two limits.

• Author of the current implementation should be specified.

• Revision of the current implementation should be specified to enable distinction
between different implementations of the block.

• Date Created is automatically specified upon the creation of the current implementation.

• Date Changed is automatically specified every time the current implementation is
changed.

• Controller Inputs of the current implementation need to be defined to be defined with
respect to Mask Inports, whereby the data type can be selected from the drop-down
menu.

• Controller Outputs of the current implementation need to be defined to be defined with
respect to Mask Outports, whereby the data type can be selected from the drop-down
menu.

• Controller Parameters of the current implementation need to be defined with respect
to Mask Outports together with any additional internal parameter can also be defined)
by clicking on the Add push-button that opens up the Controller Parameter window in
which the Name, Description, and Default Value text-fields together with the Data
Type drop-down menu and the Load & Save Enable and Array check-boxes under the
Controller Parameters section become available. Every controller parameter can also
be removed or edited by clicking on the Remove or Modify push-button, respectively.

– Controller Parameters

* Name is displayed in the dialog window of the block in both Simulink and
Scilab Xcos and denotes a parameter of the block.

* Description is displayed in the dialog window of the block in both Simulink
and Scilab Xcos and should describe the parameter of the block.

* Data Type determines the data type that is to be used on the target.

* Default Value sets the default value of the parameter.

• Conversion Function Type can be selected from the drop-down menu between Java,
Python, and JavaScript. After selecting the conversion function type, a template of the
conversion function used for the conversion of mask parameters, which are of the type
double, into the data type of the current implementation is generated. The template
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needs to be manually adapted. If there are no mask parameters, no conversion function
is necessary.

20.2 Coding the source file

The functionality of the block needs to be manually implemented in the au-
tomatically generated <BlockName>_<Implementation>.c source file located in
<ProjectRoot>\Library\<LibraryName>\Controller\src\. In that source file, ev-
erything between each pair of the comment tags /* USERCODE-BEGIN: ... */ and
/* USERCODE-END: ... */ stays unchanged even if the source file is regenerated
by X2C Block Generator. Between the first pair of such comments, namely /*

USERCODE-BEGIN:Description */ and /* USERCODE-END:Description */, a short
description of the block can be written in the form of comments. The definitions of the
input(s) and the output(s) as well as parameters, variables, constants, and if necessary, the
inclusions of header files should be defined between the PreProcessor-tags as

/ * USERCODE=BEGIN : PreProcessor * /
# inc lude "<HeaderFi le >.h "
# de f ine <INPUT> ( * pT<BlockName>_<Implementat ion >=><InportName >)
# de f ine <OUTPUT> ( pT<BlockName>_<Implementat ion >=><OutportName >)
# de f ine <PARAMETER>

( pT<BlockName>_<Implementat ion >=><ParameterName >)
# de f ine <VARIABLE>

( pT<BlockName>_<Implementat ion >=><ParameterName >)
# de f ine <CONSTANT> <HexadecimalValue >

/ * USERCODE=END: PreProcessor * /

The functionality of the block should be defined between the UpdateFnc-tags and can be
demonstrated by an example in a FiP16 implementation as

/ * USERCODE=BEGIN : UpdateFnc * /
i n t 32 <Result > ;
<Result > = ( i n t 32 ) <INPUT> * ( i n t 32 ) <VARIABLE>;
<Result > >>= <PARAMETER>;
<Result > += ( i n t 32 ) <CONSTANT>;
i f ( < Result > > INT16_MAX)
{

<Result > = INT16_MAX ;
}
e lse
{

i f ( < Result > < =INT16_MAX)
{

<Result > = =INT16_MAX ;
}

}
<OUTPUT> = ( i n t 16 ) <Result > ;

/ * USERCODE=END: UpdateFnc * /

The initial values of used variables can be specified between the InitFnc-tags as

/ * USERCODE=BEGIN : I n i t F n c * /
<Var iab le > = 0;

/ * USERCODE=END: I n i t F n c * /

Between /* USERCODE-BEGIN:LoadFnc */ and /* USERCODE-END:LoadFnc */ and be-
tween /* USERCODE-BEGIN:SaveFnc */ and /* USERCODE-END:SaveFnc */ the user can
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insert code which is executed when the save-function of the block (download of the imple-
mentation parameters from the host to the target) or the load-function of the block (upload of
the implementation parameters to the host from the target) is called. Usually these sections
are left empty.

20.3 Coding the conversion function

If the block uses mask parameters, the conversion function, which converts the mask
parameters into controller parameters, has to be implemented in the corresponding
programming language as well. The template of the conversion function is located in
<ProjectRoot>\Library\<LibraryName>\Conversion\<ConversionType>\.

20.3.1 A conversion function in Java

In the case of Java, the conversion function of the block needs to be manually imple-
mented in the automatically generated ConvFnc_<BlockName>_<Implementation>.java

file located in <ProjectRoot>\Library\<LibraryName>\Conversion\Java\src\.... Fur-
thermore, Eclipse needs to be installed on the system and the project imported into the
workspace via the menu bar as File ⇒ Import... ⇒ General ⇒ Existing Project. Under
Project ⇒ Build Automatically needs to be enabled and by right-clicking on the project in
the project tree, under Properties ⇒ Java Compiler ⇒ Compiler Compliance Level needs
to be set to 1.6. In the above mentioned file, everything between each pair of the comments
// USERCODE-BEGIN: and // USERCODE-END: stays unchanged even if the source file is
regenerated by X2C Block Generator. User-defined Java classes like

/ / USERCODE=BEGIN : Imports
impor t a t . lcm . x2c . u t i l s . QFormat ;

/ / USERCODE=END: Imports

can be loaded between the Imports-tags, while the conversion of the controller parame-
ters from the mask into the designated implementation needs to be written between the
ConvMaskToImplementation-tags and can be demonstrated by an example in a FiP16

implementation as

/ / USERCODE=BEGIN : ConvMaskToImplementation
double <ControlParameter >;
f i n a l i n t BITS = 16;

/ / Get t ing the value o f the mask parameter :
<ControlParameter > =

Double . valueOf ( <MaskParameter>MaskVal . getValue ( ) ) ;

/ / Ca l cu l a t i ng the s h i f t f a c t o r :
< Sh i f tFac to r >Ct rVa l . setReal (0 , 0 ,

Double . valueOf ( QFormat . getQFormat ( < ControlParameter > , BITS ,
t r ue ) ) ) ;

/ / Ca l cu l a t i ng the Q=value :
<ControlParameter >Ct rVa l . setReal (0 , 0 ,

Double . valueOf ( QFormat . getQValue ( < ControlParameter > ,
( i n t ) ( < Sh i f tFac to r >Ct rVa l . getReal (0 , 0) ) , BITS , t r ue ) ) ) ;

/ / USERCODE=END: ConvMaskToImplementation

The conversion of the controller parameters from the designated implementation into the
mask needs to be written between the ConvImplementationToMask-tags as
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/ / USERCODE=BEGIN : ConvImplementationToMask
double <ControlParameter > , < Sh i f tFac to r >;
f i n a l i n t BITS = 16;

/ / Get t ing the Q=value :
<ControlParameter > = <ControlParameter >Ct rVa l . getReal (0 , 0) ;

/ / Get t ing the s h i f t f a c t o r :
< Sh i f tFac to r > = < Sh i f tFac to r >Ct rVa l . getReal (0 , 0) ;

/ / Ca l cu l a t i ng the value o f the mask parameter :
<MaskParameter>MaskData . setReal (0 , 0 ,

QFormat . getDecValue ( ( long ) <ControlParameter > ,
( i n t ) < Sh i f tFac to r > , BITS , t r ue ) ) ;

/ / USERCODE=END: ConvImplementationToMask

Eventually a JAR file has to be created to make the conversion function available in Scil-
ab/Xcos. There are multiple ways to create a JAR file. One could work with *.jardesc files in
Eclipse, use Apache Ant tasks or simply build the JAR file on the command line.
Taking the command line approach as example, one has to change into the <LibraryDirec-
tory>\Conversion\Java\bin directory and execute following command:

j a r c f . . \ < LibraryName >. j a r . \

20.3.2 A conversion function in JavaScript

In the case of JavaScript, two JavaScript script files are automatically generated
in <ProjectRoot>\Library\<LibraryName>\Conversion\JavaScript\src\..., where
one is used for the conversion of the mask parameters to the implementation parameters,
while the other one is used for the conversion of the implementation parameters to the mask
parameters. The conversion of the mask parameters to the implementation parameters needs
to be manually implemented in ConvertMask2Imp_<BlockName>_<Implementation>.js,
while the conversion of the implementation parameters to the mask parameters needs to be
implemented in ConvertImp2Mask_<BlockName>_<Implementation>.js. Both files contain
/* USERCODE-BEGIN:Description */ and /* USERCODE-END:Description */ as well
as /* USERCODE-BEGIN:ExternalModules */ and /* USERCODE-END:ExternalModules

*/, where between the first pair a short description of the conversion function can be
written, while between the second pair external modules can be imported. The con-
version of the mask parameters to the implementation parameters comes between /*

USERCODE-BEGIN:Convert */ and /* USERCODE-END:Convert */ in the first file, while the
conversion of the implementation parameters to the mask parameters comes between /*

USERCODE-BEGIN:Revert */ and /* USERCODE-END:Revert */ in the second file.

20.3.3 A conversion function in Python

Similar to the case of JavaScript, in the case of Python, two Python scripts are automatically
generated in <ProjectRoot>\Library\<LibraryName>\Conversion\Python\src\...,
where the ConvertMask2Imp_<BlockName>_<Implementation>.py script is used for
the conversion of the mask parameters to the implementation parameters, while the
ConvertImp2Mask_<BlockName>_<Implementation>.py script is used for the conversion
of the implementation parameters to the mask parameters. The scripts are structurally identi-
cal to the above described JavaScript script files containing # USERCODE-BEGIN: ... and #

USERCODE-END: ... sections, where the only difference is the scripting language.
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20.4 Finalizing the block in Scilab

In Scilab execute the command

createXcosBlock ( ’ < LibraryName > ’ , ’ <BlockName > ’ , ’ < ProjectRoot > ’ )

20.5 The block in Code Composer Studio

After including the project in Code Composer Studio, the library should be listed in the project
tree. Before compiling, it is necessary to exclude the Matlab and Conversion folders from
the build.
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21 Setup X2C® for use in a B&R® Automation Studio® project

X2C allows the user to modify an already created Automation Studio project for use with X2C
and generate the corresponding code. Therefore several configuration parameters have to
be set.

21.1 Configuration

• Setup a new Automation Studio project or use an existing one

• Head to the Communicator settings and configure the the Automation Studio specific
parts

1. Enable the "Create Automation Studio code" option

2. Select the project APJ file. After a valid project is selected, the configuration menu
is updated and contains all project configurations. Further Settings elements will
be enabled and updated.

3. Select a configuration, a CPU module and a Application task class. This becomes
the task in which the X2C Update function is called.

4. Enable the Communication option in case TCP/IP communication should be used
for online X2C Block parameter updates or Scope usage. After enabling, the task
class for the X2C communication task and the TCP port can be selected.

5. The "Use library" option allows you to use X2C as Automation Studio library block.

6. Sets the X2C Scope buffer size. This buffer is used to cache the sampled data if
the Scope feature is used.

Figure 33: X2C Connector for B&R Automation Studio settings

• Confirm the changes by pressing the OK button
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• Generate the X2C code as usual

All required X2C and Automation Studio files will be created. The Automation Studio configu-
ration files are being updated to include the newly generated X2C code.
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21.2 Logical View

Now we can head over to Automation Studio to check the modifications and build the project.
Automation Studio may ask you to reload changed components.
The "Logical View" should have been updated by X2C content as well as the Software
configuration file in the "Configuration View". In case of enabled Communication, the B&R
library "AsTCP", required for TCP/IP communications, is added to your project libraries.
Therefore your Automation Studio project may look like this:

Figure 34: Automation Studio Logical View

This example shows the added

• B&R AsTCP library

• X2C as Automation Studio library

• X2C application program package

• X2C communication program package
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21.3 Software Configuration

The software configuration file shows the newly added programs and libraries.

Figure 35: Automation Studio Software Configuration

21.4 Communication configuration

In case of enabled communication don’t forget to configure the Ethernet and TCP/IP settings
for your hardware in Automation Studio .

Figure 36: Automation Studio Ethernet configuration using DHCP (X20CP1485)

The X2C integration is now complete and the Automation Studio project is ready to be built.
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Part VI

Libraries

22 Basic
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Block: CommunicatorStart (Xcos only)

Description:

ith a double-click on this block, the X2C Communicator will start. The Communicator will
connect to Scilab via Java Remote Method Invocation (Java RMI) to enable data exchange
between Scilab and X2C.
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Block: CreateDocumentation

Description:

With a double-click on this block, a documentation with all relevant information about the
current X2C project can be created. The document will be created in <ProjectDir>\Doc and
will be called ProjectDocumentation_<NameOfModel>.pdf.

Parameters

User documentation: It is possible to add user specific documentation to the project
documentation. When creating the project documentation, the X2CCode directory is scanned
for the specifed tex file (UserDoc.tex by default). If the file is present, it will be included in the
documentation.

Test reports: If the checkbox Add test reports is selected, test reports of the C-Unit tests of
the used X2C blocks are added to the project documentation.

Requirements

In order to generate a documentation in PDF-format a TeX-compiler (e.g. MiKTeX ) has to be
installed. The software tools Doxygen and Graphviz are recommended to get documentation
of the C-code.

64



Block: Interact (Xcos only)

Description:

When double-clicked, the block executes the Scilab script doInteraction.sci, if available. By
customizing the script, the user can execute simple tasks, e.g. setting block parameters, read
parameter values, display status information, etc., repeatedly and effortlessly.

65



Block: ModelTransformation (Xcos only)

Description:

With a double-click on this block, the Xcos model will be analyzed. All relevant information for
code generation are gathered, transfered to the Communicator and written to the model XML
file.
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27 Control

Block: AdaptivePT1

Inports

In Input In(k)

fc Cutoff frequency

Outports

Out Output Out(k)

Mask Parameters

Name ID Description

V 1 Gain

fmax 2 Maximum frequency [Hz]
(not used in floating point implementations)

ts_fact 3 Multiplication factor of base sampling time (in
integer format)

method 4 Discretization method

Description:

First order low pass with adaptive cut off frequency:
G(s) = V/(s/(2*pi*fc) + 1)

Transfer function (zero-order hold discretization method):

G(z) = V
1− e−2πfcTs

z − e−2πfcTs

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation
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Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

fc int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

fc int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

fc int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

fc float32
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Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

fc float64

Outports Data Type

Out float64
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Block: Delay

Inports

In Input In(k)

Outports

Out Output Out(k)=In(k-1)

Mask Parameters

Name ID Description

ts_fact 1 Multiplication factor of base sampling time (in
integer format)

Description:

Output delay by one sample time interval.

This block can be used to enable feedback loops in the model.

Implementations:

Bool Boolean Integration

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: Bool

Boolean Integration

Inports Data Type

In bool

Outports Data Type

Out bool
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Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: DT1

Inports

In Input In(k)

Outports

Out Output Out(k)

Mask Parameters

Name ID Description

V 1 Gain

fc 2 Cut off frequency of low pass filter

ts_fact 3 Multiplication factor of base sampling time (in
integer format)

method 4 Discretization method

Description:

First order high pass:
G(s) = V*s/(s/w + 1)

Due to limited value range in the 8 bit fixed point implementation rather high deviations from
expected output values may occur.

Developer note: The source code of block TF1 is used.

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8
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Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64
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Outports Data Type

Out float64
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Block: I

Inports

In Control error input

Init Value which is loaded at initialization function call

Enable Enable == 0: Deactivation of block; Out set to 0
Enable 0->1: Preload of integral part
Enable == 1: Activation of block

Outports

Out Control value

Mask Parameters

Name ID Description

Ki 1 Integral Factor

ts_fact 2 Multiplication factor of base sampling time (in
integer format)

Description:

I controller:
G(s) = Ki/s = 1/(Ti*s)

Each fixed point implementation uses the next higher integer datatype for the integrational
value storage variable.
A rising flank at the Enable inport will preload the integrational part with the value present on
the Init inport.

Transfer function (zero-order hold discretization method):

G(z) = KiTs
1

z − 1

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation
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Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Init int8

Enable bool

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Init int16

Enable bool

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Init int32

Enable bool

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation
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Inports Data Type

In float32

Init float32

Enable bool

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Init float64

Enable bool

Outports Data Type

Out float64
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Block: PI

Inports

In Control error input

Init Value which is loaded at initialization function call

Enable Enable == 0: Deactivation of block; Out set to 0
Enable 0->1: Preload of integral part
Enable == 1: Activation of block

Outports

Out

Mask Parameters

Name ID Description

Kp 1 Proportional Factor

Ki 2 Integral Factor

ts_fact 3 Multiplication factor of base sampling time (in
integer format)

Description:

PI controller:
G(s) = Kp + Ki/s

Each fixed point implementation uses the next higher integer data type for the integral value
storage variable.
A rising flank at the Enable inport will preload the integral part with the value present on the
Init inport.

Transfer function (zero-order hold discretization method):

G(z) = Kp +KiTs
1

z − 1

Developer note: For the fixed point implementations the source code of block Block: PILimit
is used.
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Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Init int8

Enable int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Init int16

Enable bool

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Init int32

Enable bool
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Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Init float32

Enable bool

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Init float64

Enable bool

Outports Data Type

Out float64
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Block: PID

Inports

In Control error input

Init Value which is loaded at initialization function call

Enable Enable == 0: Deactivation of block; Out set to 0
Enable 0->1: Preload of integral part
Enable == 1: Activation of block

Outports

Out

Mask Parameters

Name ID Description

Kp 1 Proportional Factor

Ki 2 Integral Factor

Kd 3 Derivative Factor

fc 4 Cutoff frequency of realization low pass

ts_fact 5 Multiplication factor of base sampling time (in
integer format)

Description:

PID controller:
G(s) = Kp + Ki/s + Kd*s/(s/(2*pi*fc) + 1)

Each fixed point implementation uses the next higher integer datatype for the integrational
value storage variable.
A rising flank at the Enable inport will preload the integrational part with the value present on
the Init inport.

Transfer function (zero-order hold discretization method):

G(z) = Kp +KiTs
1

z − 1
+Kd2πfc

z − 1

z − e−2πfcTs

FiP8 bug: When using the TI compiler the step response of the derivative part does not
return to zero, but generates an overflow at zero crossing if the derivative parameter value is
too high.

Developer note: For the fixed point implementations the source code of block PIDLimit is
used.
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Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Init int8

Enable int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Init int16

Enable bool

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Init int32

Enable bool
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Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Init float32

Enable bool

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Init float64

Enable bool

Outports Data Type

Out float64

83



Block: PIDLimit

Inports

In Control error input

Init Value which is loaded at initialization function call

max Maximum output value

min Minimum output value

Enable Enable == 0: Deactivation of block; Out set to 0
Enable 0->1: Preload of integral part
Enable == 1: Activation of block

Outports

Out

Mask Parameters

Name ID Description

Kp 1 Proportional Factor

Ki 2 Integral Factor

Kd 3 Derivative Factor

fc 4 Cutoff frequency of realization low pass

ts_fact 5 Multiplication factor of base sampling time (in
integer format)

Description:

PID Controller with Output Limitation:
G(s) = Kp + Ki/s + Kd*s/(s/(2*pi*fc) + 1)

Each fixed point implementation uses the next higher integer datatype for the integrational
value storage variable.
A rising flank at the Enable inport will preload the integrational part with the value present on
the Init inport.

Transfer function (zero-order hold discretization method):

G(z) = Kp +KiTs
1

z − 1
+Kd2πfc

z − 1

z − e−2πfcTs

FiP8 bug: When using the TI compiler the step response of the derivative part doesn’t
return to zero, but generates an overflow at zero crossing if the derivative parameter value is
too high.

84



Developer note: The fixed point implementation source code of this block is used for block
PID.

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Init int8

max int8

min int8

Enable int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Init int16

max int16

min int16

Enable bool

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation
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Inports Data Type

In int32

Init int32

max int32

min int32

Enable bool

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Init float32

max float32

min float32

Enable bool

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Init float64

max float64

min float64

Enable bool

Outports Data Type

Out float64
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Block: PILimit

Inports

In Control error input

Init Value which is loaded at initialization function call

max Maximum output value

min Minimum output value

Enable Enable == 0: Deactivation of block; Out set to 0
Enable 0->1: Preload of integral part
Enable == 1: Activation of block

Outports

Out

Mask Parameters

Name ID Description

Kp 1 Proportional Factor

Ki 2 Integral Factor

ts_fact 3 Multiplication factor of base sampling time (in
integer format)

Description:

PI controller with output limitation:
G(s) = Kp + Ki/s

Each fixed point implementation uses the next higher integer data type for the integral value
storage variable.
A rising flank at the Enable inport will preload the integral part with the value present on the
Init inport.

Transfer function (zero-order hold discretization method):

G(z) = Kp +KiTs
1

z − 1

Developer note: The fixed point implementation source code of this block is used for block
Block: PI.
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Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Init int8

max int8

min int8

Enable int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Init int16

max int16

min int16

Enable bool

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation
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Inports Data Type

In int32

Init int32

max int32

min int32

Enable bool

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Init float32

max float32

min float32

Enable bool

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Init float64

max float64

min float64

Enable bool

Outports Data Type

Out float64
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Block: PT1

Inports

In Input In(k)

Outports

Out Output Out(k)

Mask Parameters

Name ID Description

V 1 Gain

fc 2 Cut off frequency of low pass filter

ts_fact 3 Multiplication factor of base sampling time (in
integer format)

method 4 Discretization method

Description:

First order low pass:
G(s) = V/(s/w + 1)

Due to limited value range in the 8 bit fixed point implementation rather high deviations from
expected output values may occur.

Developer note: The source code of block TF1 is used.

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8
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Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64
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Outports Data Type

Out float64
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Block: TDSystemO1

Inports

In Input #1

Outports

Out Output #1

Mask Parameters

Name ID Description

A 1 State matrix A

B 2 Input matrix B

C 3 Output matrix C

D 4 Feedthrough matrix D

Description:

1st order time discrete system with one input and one output.

Calculation:

x1,k+1 = a1,1x1,k + b1,1u1,k

y1,k = c1,1x1,k + d1,1u1,k

or short

xk+1 = Axk +Buk

yk = Cxk +Duk

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation
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Inports Data Type

In int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation
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Inports Data Type

In float64

Outports Data Type

Out float64
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Block: TDSystemO2

Inports

In1 Input #1

In2 Input #2

Outports

Out1 Output #1

Out2 Output #2

Mask Parameters

Name ID Description

A 1 State matrix A

B 2 Input matrix B

Description:

2nd order time discrete system with two inputs and two outputs.

Calculation: [
x1,k+1

x2,k+1

]
=

[
a1,1 a1,2

a2,1 a2,2

][
x1,k

x2,k

]
+

[
b1,1 b1,2

b2,1 b2,2

][
u1,k

u2,k

]
[
y1,k

y2,k

]
=

[
1 0

0 1

][
x1,k

x2,k

]
+

[
0 0

0 0

][
u1,k

u2,k

]

or short

xk+1 = Axk +Buk

yk = xk

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation
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Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In1 int8

In2 int8

Outports Data Type

Out1 int8

Out2 int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In1 int16

In2 int16

Outports Data Type

Out1 int16

Out2 int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In1 int32

In2 int32

Outports Data Type

Out1 int32

Out2 int32

Implementation: Float32

32 Bit Floating Point Implementation
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Inports Data Type

In1 float32

In2 float32

Outports Data Type

Out1 float32

Out2 float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In1 float64

In2 float64

Outports Data Type

Out1 float64

Out2 float64
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Block: TF1

Inports

In Input In(k)

Outports

Out Output Out(k)

Mask Parameters

Name ID Description

b1 1 b1

b0 2 b0

a0 3 a0

ts_fact 4 Multiplication factor of base sampling time (in
integer format)

Description:

First order transfer function:
G(z) = (b1.z + b0) / (z + a0)

Due to limited value range in the 8 bit fixed point implementation rather high deviations from
expected output values may occur.

Developer note: The source code of this block is used for blocks DT1 and PT1.

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8
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Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64
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Outports Data Type

Out float64
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Block: TF2

Inports

In Input In(k)

Outports

Out Output Out(k)

Mask Parameters

Name ID Description

b2 1 b2

b1 2 b1

b0 3 b0

a1 4 a1

a0 5 a0

ts_fact 6 Multiplication factor of base sampling time (in
integer format)

Description:

Second order transfer function:
G(z) = (b2.z2 + b1.z + b0) / (z2 + a1.z + a0)

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP8 8 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16
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Outports Data Type

Out int16

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Outports Data Type

Out int8

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64
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Outports Data Type

Out float64
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Block: uI

Inports

In Control error input

Init Value which is loaded at initialization function call

Enable Enable == 0: Deactivation of block; Out is set to 0.
Enable 0->1: Preload of integral part.
Enable == 1: Activation of block

Outports

Out Integrator output

Mask Parameters

Name ID Description

Ki 1 Integral Factor

ts_fact 2 Multiplication factor of base sampling time (in
integer format)

Description:

Integrator for angle signals:
G(s) = Ki/s = 1/(Ti*s)

Each fixed point implementation uses the next higher integer datatype for the integrational
value storage variable.
A rising flank at the Enable inport will preload the integrational part with the value present on
the Init inport.

Transfer function (zero-order hold discretization method):

G(z) = KiTs
1

z − 1

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation
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Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Init int8

Enable bool

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Init int16

Enable bool

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Init int32

Enable bool

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation
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Inports Data Type

In float32

Init float32

Enable bool

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Init float64

Enable bool

Outports Data Type

Out float64
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42 Filter

Block: ACDC

Inports

In Input signal

phi Angle signal

Outports

AC AC part of input signal

DC DC part of input signal

Mask Parameters

Name ID Description

ts_fact 1 Multiplication factor of base sampling time (in
integer format)

Description:

Calculation of AC and DC part of input signal.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

phi int16
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Outports Data Type

AC int16

DC int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

phi int32

Outports Data Type

AC int32

DC int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

phi float32

Outports Data Type

AC float32

DC float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

phi float64

Outports Data Type

AC float64

DC float64
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Block: AdaptiveNotch

Inports

In Input signal

n Speed input = notch frequency

Outports

Out Filtered output signal

Mask Parameters

Name ID Description

Q 1 Q-Factor of the notch filter

n_thresh 2 Speed threshold for activating the filter

n_max 3 Maximum revolutions per minute
(Not used in floating point implementations)

p 4 Number of pole pairs

ts_fact 5 Multiplication factor of base sampling time (in
integer format)

method 6 Discretization method

Description:

Notch filter with variable notch frequency

Calculation:

Out(k) =

{
In(k) n(k) ≤ nthresh

In(k) ·H(z) n(k) > nthresh

The transfer function H(z) of the filter is

H(z) =
b0 + b1z

−1 + b2z
−2

1 + a1z−1 + a2z−2

with coefficients derived from the transfer function

H(s) =
s2 + ω2

0

s2 + ω0
Q + ω2

0

by a matched Z-transformation.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation
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Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

n int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

n int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

n float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

n float64
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Outports Data Type

Out float64
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Block: BandpassBiQ

Inports

In Input In(k)

Outports

Out Output Out(k)

Mask Parameters

Name ID Description

characteristic 1 The filter characteristic is one of Butterworth
(=Bessel) or Chebyshev

fc1 2 Lower cut-off frequency in Hz

fc2 3 Upper cut-off frequency in Hz

rc 4 Attenuation at cut-off frequencies

ts_fact 5 Multiplication factor of base sampling time (in
integer format)

Description:

Calculates the filter coefficients for a second order bandpass and performs filtering on input
signal.
Second order transfer function used:
H(z) = (b0.z2 + b1.z + b2) / (z2 + a1.z + a2)

Butterworth

• center frequency fc

– center frequency fc is given by fc
2 = fc1

2 ∗ fc22

– zero phaseshift @center frequency fc

• @lower cut-off frequency fc1

– -3dB attenuation

– 45 degree phaseshift

• @upper cut-off frequency fc2

– -3dB attenuation

– -45 degree phaseshift

• stopband

– monotonic -20dB decline per decade

– roll-off dynamics are constant and not adjustable
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E.g.:
The cut-off frequencies are fc1 = 10Hz and fc2 = 100Hz.
The bodeplot is shown in the figure 37 below.

Figure 37: Bodeplot Butterworth bandpass.

Chebyshev
Note: A second order Chebyshev I bandpass has the same bodeplot as a second order
Chebyshev II bandpass. Hence, only the ’Chebyshev’ option is given.

• center frequency fc

– center frequency fc is given by fc
2 = fc1

2 ∗ fc22

– zero phaseshift @center frequency fc

• @lower cut-off frequency fc1

– −rcdB attenuation

– phaseshift proportional to rc

• @upper cut-off frequency fc2

– −rcdB attenuation

– -phaseshift proportional to rc

• stopband

– monotonic -20dB decline per decade

– roll-off dynamics are adjustable using parameter rc

E.g.:
The cut-off frequencies are fc1 = 10Hz and fc2 = 100Hz.
The parameter rc is set to 10dB.
The bodeplot is shown in the figure 38 below.
Bessel
Note: A second order Bessel bandpass behaves exactly like a second order Butterworth
bandpass. Hence, no ’Bessel’ option is given.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation
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Figure 38: Bodeplot Chebyshev bandpass. rc = 10dB

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64
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64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: BandstopBiQ

Inports

In Input In(k)

Outports

Out Output Out(k)

Mask Parameters

Name ID Description

characteristic 1 The filter characteristic is one of Butterworth
(=Bessel) or Chebyshev

fc1 2 Lower cut-off frequency in Hz

fc2 3 Upper cut-off frequency in Hz

rc 4 Attenuation at cut-off frequencies

ts_fact 5 Multiplication factor of base sampling time (in
integer format)

Description:

Calculates the filter coefficients for a second order bandstop and performs filtering on input
signal.
Second order transfer function used:
H(z) = (b0.z2 + b1.z + b2) / (z2 + a1.z + a2)

Butterworth

• center frequency fc

– center frequency fc is given by fc
2 = fc1

2 ∗ fc22

– phase discontinuity @center frequency fc

• @lower cut-off frequency fc1

– -3dB attenuation

– -45 degree phaseshift

• @upper cut-off frequency fc2

– -3dB attenuation

– 45 degree phaseshift

• passband

– roll-off dynamics are constant and not adjustable
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Figure 39: Bodeplot Butterworth bandstop.

E.g.:
The cut-off frequencies are fc1 = 100Hz and fc2 = 300Hz.
The bodeplot is shown in the figure 39 below.
Chebyshev
Note: A second order Chebyshev I bandstop has the same bodeplot as a second order
Chebyshev II bandstop. Hence, only the ’Chebyshev’ option is given.

• center frequency fc

– center frequency fc is given by fc
2 = fc1

2 ∗ fc22

– phase discontinuity @center frequency fc

• @lower cut-off frequency fc1

– −rcdB attenuation

– -phaseshift proportional to rc

• @upper cut-off frequency fc2

– −rcdB attenuation

– phaseshift proportional to rc

• passband

– roll-off dynamics are adjustable using parameter rc

E.g.:
The cut-off frequencies are fc1 = 100Hz and fc2 = 300Hz.
The parameter rc is set to 10dB.
The bodeplot is shown in the figure 40 below.
Bessel
Note: A second order Bessel bandstop behaves exactly like a second order Butterworth
bandstop. Hence, no ’Bessel’ option is given.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation
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Figure 40: Bodeplot Chebyshev bandstop. rc = 10dB

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64
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64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: Bilin

Inports

In Input In(k)

Outports

Out Output Out(k)

Mask Parameters

Name ID Description

b0 1 Filter coefficient b0

b1 2 Filter coefficient b1

a0 3 Filter coefficient a0

a1 4 Filter coefficient a1

ts_fact 5 Multiplication factor of base sampling time (in
integer format)

Description:

First order transfer function:
H(z) = (b0.z + b1) / (a0.z + a1)

Alternative representation of the same transfer function:

H(z) =
b0 + b1z

−1

a0 + a1z−1

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16
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Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: Biquad

Inports

In Input In(k)

Outports

Out Output Out(k)

Mask Parameters

Name ID Description

b0 1 Filter coefficient b0

b1 2 Filter coefficient b1

b2 3 Filter coefficient b2

a0 4 Filter coefficient a0

a1 5 Filter coefficient a1

a2 6 Filter coefficient a2

ts_fact 7 Multiplication factor of base sampling time (in
integer format)

Description:

Second order transfer function:
H(z) = (b0.z2 + b1.z + b2) / (a0.z2 + a1.z + a2)

Alternative representation of the same transfer function:

H(z) =
b0 + b1z

−1 + b2z
−2

a0 + a1z−1 + a2z−2

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16
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Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: FundFreq

Inports

In Input signal

phi Angle signal

Outports

Out First harmonic

Mask Parameters

Name ID Description

ts_fact 1 Multiplication factor of base sampling time (in
integer format)

Description:

Calculation of the first harmonic (fundamental frequency) of the input signal.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

phi int16

Outports Data Type

Out int16
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Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

phi int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

phi float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

phi float64

Outports Data Type

Out float64
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Block: HighpassBiQ

Inports

In Input In(k)

Outports

Out Output Out(k)

Mask Parameters

Name ID Description

characteristic 1 The filter characteristic is one of Butterworth,
Chebyshev I, Chebyshev II (also known as inverse
Chebyshev) or Bessel

fc 2 Cut-off frequency in Hz

rp 3 The passband ripple is only used and verified with
’Chebyshev I’ filters.
Must be a positive number

rs 4 The stopband ripple is only used and verified with
’Chebyshev II’ filters.
Must be a positive number

ts_fact 5 Multiplication factor of base sampling time (in
integer format)

Description:

Calculates the filter coefficients for a second order highpass and performs filtering on input
signal.
Second order transfer function used:
H(z) = (b0.z2 + b1.z + b2) / (z2 + a1.z + a2)

Butterworth

• passband

– maximal flat

• @cut-off frequency:

– -3dB attenuation

– -90 degree phaseshift

• stopband

– monotonic -40dB decline per decade

– approx. -37dB decline within fist decade
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Figure 41: Bodeplot Butterworth highpass.

E.g.: Cut-off frequency is 10Hz. The bodeplot is shown in the figure 41 below.
Chebyshev I

• passband:

– N/2=1 ripple in the passband.

– attenuation from 0 to rp [dB].

• @cut-off frequency: attenuation is bigger than or equal rp [dB].

• stopband:

– monotonic -40dB decline per decade

• Trade-off:

– the bigger passband ripple rp is choosen, the steeper is the magnitude cut-off
within the first decade in stopband

– the bigger the passband ripple rp is choosen, the bigger is the overall passband
attenuation!

E.g.:
Cut-off frequency is 10Hz.
The maximal ripple in the passband rp must be given in [dB].
To show the mentioned trade-off, two bodelplots are shown. One with a small and one with a
bigger rp. The bodeplot is shown in the figures 42 and 43 below.

Figure 42: Bodeplot Chebyshev I highpass. rp = 5dB

Chebyshev II
Also known as inverse Chebyshev filter.
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Figure 43: Bodeplot Chebyshev I highpass. rp = 20dB

• passband

– flat, no ripples

• @cut-off frequency: attenuation is rs [dB].

• stopband

– N/2=1 ripple in the stopband

– attenuation is smaller than or equal rs [dB].

• Trade-off:

– the lower rs is choosen, the sharper is the magnitude cut-off

– the lower rs is choosen, the lower is the over all stopband attenuation

E.g.:
Cut-off frequency is 10Hz.
The maximal ripple in the stopband rs must be given in [dB].
To show the mentioned trade-off, two bodelplots are shown. One with a small and one with a
bigger rs. The bodeplot is shown in the figures 44 and 45 below.

Figure 44: Bodeplot Chebyshev II highpass. rs = 5dB

Bessel

• passband

– constant group-delay in passband.

– least sharp magnitude roll-off.

• @cut-off frequency:
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Figure 45: Bodeplot Chebyshev II highpass. rs = 20dB

– approx. -1.6 dB attenuation

– approx. -56 degree phaseshift

• stopband

– monotonic -40dB decline per decade

– approx. -30dB decline within first decade

E.g.:
Cut-off frequency is 10Hz.
The bodeplot is shown in the figure 46 below.

Figure 46: Bodeplot Bessel highpass.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16
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Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: IIR

Inports

In Input In(k)

Outports

Out Output Out(k)

Mask Parameters

Name ID Description

CoeffB 1 Array with filter coefficients of numerator

CoeffA 2 Array with filter coefficients of denominator

ts_fact 3 Multiplication factor of base sampling time (in
integer format)

Description:

Transfer function:
H(z) = (b0.z^n + b1.z + ...+ bn) / (a0.z^n + a1.z + ... + an)
The maximum filter order is 32.
The order of the denominator has to be greater than or equal to the order of the numerator.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16
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Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: LowpassBiQ

Inports

In Input In(k)

Outports

Out Output Out(k)

Mask Parameters

Name ID Description

characteristic 1 The filter characteristic is one of Butterworth,
Chebyshev I, Chebyshev II (also known as inverse
Chebyshev) or Bessel

fc 2 Cut-off frequency in Hz

rp 3 The passband ripple is only used and verified with
’Chebyshev I’ filters.
Must be a positive number

rs 4 The stopband ripple is only used and verified with
’Chebyshev II’ filters.
Must be a positive number

ts_fact 5 Multiplication factor of base sampling time (in
integer format)

Description:

Calculates the filter coefficients for a second order lowpass and performs filtering on input
signal.
Second order transfer function used:
H(z) = (b0.z2 + b1.z + b2) / (z2 + a1.z + a2)

Butterworth

• passband

– maximal flat

• @cut-off frequency:

– -3dB attenuation

– -90 degree phaseshift

• stopband

– monotonic -40dB decline per decade

– approx. -37dB decline within fist decade
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Figure 47: Bodeplot Butterworth lowpass.

E.g.: Cut-off frequency is 10Hz. The bodeplot is shown in the figure 47 below.
Chebyshev I

• passband:

– N/2=1 ripple in the passband.

– attenuation from 0 to rp [dB].

• @cut-off frequency: attenuation is bigger than or equal rp [dB].

• stopband:

– monotonic -40dB decline per decade

• Trade-off:

– the bigger passband ripple rp is choosen, the steeper is the magnitude cut-off
within the first decade in stopband

– the bigger the passband ripple rp is choosen, the bigger is the overall passband
attenuation!

E.g.:
Cut-off frequency is 10Hz.
The maximal ripple in the passband rp must be given in [dB].
To show the mentioned trade-off, two bodelplots are shown. One with a small and one with a
bigger rp. The bodeplot is shown in the figures 48 and 49 below.

Figure 48: Bodeplot Chebyshev I lowpass. rp = 5dB

Chebyshev II
Also known as inverse Chebyshev filter.
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Figure 49: Bodeplot Chebyshev I lowpass. rp = 20dB

• passband

– flat, no ripples

• @cut-off frequency: attenuation is rs [dB].

• stopband

– N/2=1 ripple in the stopband

– attenuation is smaller than or equal rs [dB].

• Trade-off:

– the lower rs is choosen, the sharper is the magnitude cut-off

– the lower rs is choosen, the lower is the over all stopband attenuation

E.g.:
Cut-off frequency is 10Hz.
The maximal ripple in the stopband rs must be given in [dB].
To show the mentioned trade-off, two bodelplots are shown. One with a small and one with a
bigger rs. The bodeplot is shown in the figures 50 and 51 below.

Figure 50: Bodeplot Chebyshev II lowpass. rs = 20dB

Bessel

• passband

– constant group-delay in passband.

– least sharp magnitude roll-off.

• @cut-off frequency:
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Figure 51: Bodeplot Chebyshev II lowpass. rs = 5dB

– approx. -1.6 dB attenuation

– approx. -56 degree phaseshift

• stopband

– monotonic -40dB decline per decade

– approx. -30dB decline within first decade

E.g.:
Cut-off frequency is 10Hz.
The bodeplot is shown in the figure 52 below.

Figure 52: Bodeplot Bessel lowpass.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16
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Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: MinMaxPeriodic

Inports

In Input signal

phi Angle signal

Outports

max Maximum of input signal

min Minimum of input signal

Description:

Outputs the minimum and maximum of the input signal over one period of the (angle) signal
phi.

Exemplary signal waveforms:
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Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

phi int16

Outports Data Type

max int16

min int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

phi int32

Outports Data Type

max int32

min int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

phi float32

Outports Data Type

max float32

min float32
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Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

phi float64

Outports Data Type

max float64

min float64
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54 General

Block: And

Inports

In1

In2

Outports

Out

Description:

Logical AND block.

Implementations:

Bool Boolean Implementation

Implementation: Bool

Boolean Implementation

Inports Data Type

In1 bool

In2 bool

Outports Data Type

Out bool
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Block: AutoSwitch

Inports

In1 Input #1

Switch Input #2: Threshold signal

In3 Input #3

Outports

Out Either value of input #1 or input #3 dependent on value of
input #2

Mask Parameters

Name ID Description

Thresh_up 1 Threshold level for rising switch signal

Thresh_down 2 Threshold level for falling switch signal

Description:

Switch between In1 and In3 dependent on Switch signal:
Switch signal rising: Switch >= Threshold up –> Out = In1
Switch signal falling: Switch < Threshold down –> Out = In3

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In1 int16

Switch int16

In3 int16

Outports Data Type

Out int16
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Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In1 int32

Switch int32

In3 int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In1 float32

Switch float32

In3 float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In1 float64

Switch float64

In3 float64

Outports Data Type

Out float64
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Block: Constant

Outports

Out Constant output

Mask Parameters

Name ID Description

Value 1 Constant factor

Description:

Constant value.

Implementations:

Bool Boolean Implementation

Int8 8 Bit Integer Implementation

Int16 16 Bit Integer Implementation

Int32 32 Bit Integer Implementation

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: Bool

Boolean Implementation

Outports Data Type

Out bool

Implementation: Int8

8 Bit Integer Implementation

Outports Data Type

Out int8
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Implementation: Int16

16 Bit Integer Implementation

Outports Data Type

Out int16

Implementation: Int32

32 Bit Integer Implementation

Outports Data Type

Out int32

Implementation: FiP8

8 Bit Fixed Point Implementation

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Outports Data Type

Out float32

146



Implementation: Float64

64 Bit Floating Point Implementation

Outports Data Type

Out float64
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Block: Gain

Inports

In Input

Outports

Out Amplified input

Mask Parameters

Name ID Description

Gain 1 Gain factor in floating point format

Description:

Amplification of input by gain factor.

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation
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Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: Inport

Inports

IN Signal from frame program

Mask Parameters

ts_fact Multiplication factor of base sampling time (in integer
format)

Gain Gain value used in simulation

Offset Offset value used in simulation

Description:

Serves as interface to the frame program. The input of this block is intended for simulation
purposes and can be left unconnected if not used. Also the parameters Gain and Offset are
only used during simulation. The schematic for simulation can be seen in the figure below.
Note: Currently, Gain and Offset parameters are only available in Matlab/Simulink.

Data Types:

int8 8 Bit Fixed Point

int16 16 Bit Fixed Point

int32 32 Bit Fixed Point

float32 32 Bit Floating Point

float64 64 Bit Floating Point
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Block: Int2Real

Inports

In Integer input

Outports

Out Real output

Mask Parameters

Name ID Description

Scale 1 Scaling factor from integer to real

Description:

Conversion block from integer (fixed point) datatypes to real (floating point) datatypes.
Out = In * Scale

Implementations:

FiP8_Float32 8 Bit Fixed Point to 32 Bit Floating Point Implementation

FiP16_Float32 16 Bit Fixed Point to 32 Bit Floating Point Implementation

FiP32_Float32 32 Bit Fixed Point to 32 Bit Floating Point Implementation

FiP8_Float64 8 Bit Fixed Point to 64 Bit Floating Point Implementation

FiP16_Float64 16 Bit Fixed Point to 64 Bit Floating Point Implementation

FiP32_Float64 32 Bit Fixed Point to 64 Bit Floating Point Implementation

Bool_Float32 Boolean to 32 Bit Floating Point Implementation

Bool_Float64 Boolean to 64 Bit Floating Point Implementation

Implementation: FiP8_Float32

8 Bit Fixed Point to 32 Bit Floating Point Implementation

Inports Data Type

In int8

Outports Data Type

Out float32
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Implementation: FiP16_Float32

16 Bit Fixed Point to 32 Bit Floating Point Implementation

Inports Data Type

In int16

Outports Data Type

Out float32

Implementation: FiP32_Float32

32 Bit Fixed Point to 32 Bit Floating Point Implementation

Inports Data Type

In int32

Outports Data Type

Out float32

Implementation: FiP8_Float64

8 Bit Fixed Point to 64 Bit Floating Point Implementation

Inports Data Type

In int8

Outports Data Type

Out float64

Implementation: FiP16_Float64

16 Bit Fixed Point to 64 Bit Floating Point Implementation

Inports Data Type

In int16

Outports Data Type

Out float64
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Implementation: FiP32_Float64

32 Bit Fixed Point to 64 Bit Floating Point Implementation

Inports Data Type

In int32

Outports Data Type

Out float64

Implementation: Bool_Float32

Boolean to 32 Bit Floating Point Implementation

Inports Data Type

In bool

Outports Data Type

Out float32

Implementation: Bool_Float64

Boolean to 64 Bit Floating Point Implementation

Inports Data Type

In bool

Outports Data Type

Out float64

153



Block: Limitation

Inports

In Input signal

max Upper limit

min Lower limit

Outports

Out Limited input signal

Description:

Limits the input signal to min and max_sci.
Caution: For correct computation the upper limit max has to be greater than the lower limit
min!

Calculation:

Out =


max In > max

In

min In < min

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

max int16

min int16

Outports Data Type

Out int16
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Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

max int32

min int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

max float32

min float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

max float64

min float64

Outports Data Type

Out float64
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Block: LookupTable

Inports

In Table index

Outports

Out Table output

Mask Parameters

Name ID Description

Lookup 1 Look-up Table

Description:

Look-up Table with 256+1 values.
Note: 257th value is used for preventing index overflow during interpolation.
-> for periodic signals the 257th value should be set equal to 1st value
-> for non-periodic signals the 257th value should be set equal to 256th value

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation
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Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32
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Block: LookupTable1D

Inports

x Table index in x direction

Outports

Out Table output

Mask Parameters

Name ID Description

TableData 1 Look-up table data

DimX 2 Number of data points in x-direction

x_min 3 Minimum input value of x-dimension for look-up
table

x_max 4 Maximum input value of x-dimension for look-up
table

Description:

One dimensional look-up table with selectable number of data points.
Table data must be an array of size DimX.
If input is out of specified range, output will be cut off (no extrapolation).

The table of the LookupTable1D block must contain DimX data points and they have to be
arranged as

TableData = [f(x1), f(x2), ... f(xn−1), f(xn)]

with n as the selected DimX value.
For periodic signals, the last entry must be identical to the first entry, see the example in the
following figure.
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For non-periodic signals there is no restriction regarding the last data point, see the example
in the figure below.
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Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

x int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

x int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

x float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation
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Inports Data Type

x float64

Outports Data Type

Out float64

161



Block: LookupTable2D

Inports

x Table index in x direction

y Table index in y direction

Outports

Out Table output

Mask Parameters

Name ID Description

TableData 1 Look-up table data

DimX 2 Number of data points in x-direction

x_min 3 Minimum input value of x-dimension for look-up
table

x_max 4 Maximum input value of x-dimension for look-up
table

DimY 5 Number of data points in y-direction

y_min 6 Minimum input value of y-dimension for look-up
table

y_max 7 Maximum input value of y-dimension for look-up
table

Description:

Two dimensional look-up table with selectable number of data points.
Table data must be an array of size DimX*DimY.
If input is out of specified range, output will be cut off (no extrapolation).

The table of the LookupTable2D block must contain DimX times DimY data points and they
have to be arranged as

TableData =[f(x1, y1), f(x2, y1), ... f(xn−1, y1), f(xn, y1),

f(x1, y2), f(x2, y2), ... f(xn−1, y2), f(xn, y2),

...

f(x1, ym−1), f(x2, ym−1), ... f(xn−1, ym−1), f(xn, ym−1),

f(x1, ym), f(x2, ym), ... f(xn−1, ym), f(xn, ym)]

with n as selected DimX and m as selected DimY values.
For periodic signals, the last entries per dimension must be identical to the first entries in this
dimension, see the example in the following figure.
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For non-periodic signals there is no restriction regarding the last data points, see the example
in the figure below.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16
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16 Bit Fixed Point Implementation

Inports Data Type

x int16

y int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

x int32

y int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

x float32

y float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

x float64

y float64

Outports Data Type

Out float64
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Block: LookupTable3D

Inports

x Table index in x direction

y Table index in y direction

z Table index in z direction

Outports

Out Table output

Mask Parameters

Name ID Description

TableData 1 Look-up table data

DimX 2 Number of data points in x-direction

x_min 3 Minimum input value of x-dimension for look-up
table

x_max 4 Maximum input value of x-dimension for look-up
table

DimY 5 Number of data points in y-direction

y_max 6 Maximum input value of y-dimension for look-up
table

y_min 7 Minimum input value of y-dimension for look-up
table

DimZ 8 Number of data points in z-direction

z_min 9 Minimum input value of z-dimension for look-up
table

z_max 10 Maximum input value of z-dimension for look-up
table

Description:

Three dimensional look-up table with selectable number of data points.
Table data must be an array of size DimX*DimY*DimZ.
If input is out of specified range, output will be cut off (no extrapolation).

The table of the LookupTable3D block must contain DimX times DimY times DimZ data points
and they have to be arranged as
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TableData =[f(x1, y1, z1), f(x2, y1, z1), ... f(xn−1, y1, z1), f(xn, y1, z1),

f(x1, y2, z1), f(x2, y2, z1), ... f(xn−1, y2, z1), f(xn, y2, z1),

...

f(x1, ym−1, z1), f(x2, ym−1, z1), ... f(xn−1, ym−1, z1), f(xn, ym−1, z1),

f(x1, ym, z1), f(x2, ym, z1), ... f(xn−1, ym, z1), f(xn, ym, z1)

f(x1, y1, z2), f(x2, y1, z2), ... f(xn−1, y1, z2), f(xn, y1, z2),

f(x1, y2, z2), f(x2, y2, z2), ... f(xn−1, y2, z2), f(xn, y2, z2),

...

f(x1, ym−1, zk), f(x2, ym−1, zk), ... f(xn−1, ym−1, zk), f(xn, ym−1, zk),

f(x1, ym, zk), f(x2, ym, zk), ... f(xn−1, ym, zk), f(xn, ym, zk)]

with n as selected DimX, m as selected DimY and k as selected DimZ values.
For interpolation of the data, the trilinear interpolation method is used. The interpolation is
implemented as

f(x, y, z) = c0 + c1∆x+ c2∆y + c3∆z + c4∆x∆y + c5∆y∆z + c6∆z∆x+ c7∆x∆y∆z

with ∆x, ∆y, ∆z as relative distances to the starting point f000 and with the coefficients

c0 = f000

c1 = f100 − f000

c2 = f010 − f000

c3 = f001 − f000

c4 = f110 − f010 − f100 + f000

c5 = f011 − f001 − f010 + f000

c6 = f101 − f001 − f100 + f000

c7 = f111 − f011 − f101 − f110 + f100 + f001 + f010 − f000

derived from the lattice points relative to the starting point.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

x int16

y int16

z int16
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Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

x int32

y int32

z int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

x float32

y float32

z float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

x float64

y float64

z float64

Outports Data Type

Out float64
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Block: LoopBreaker

Inports

In Input In(k)

Outports

Out Output Out(k)=In(k-1)

Description:

Block to break algebraic loops.

Implementations:

Bool Boolean Integration

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: Bool

Boolean Integration

Inports Data Type

In bool

Outports Data Type

Out bool

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16
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Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64

169



Block: ManualSwitch

Inports

In1 Input #1

In2 Input #2

Outports

Out

Mask Parameters

Name ID Description

Toggle 1 Toggle

Description:

Toggling between inputs by double-clicking on block.

Doubleclicking of the ManualSwitch block changes the routing of the input signals and doesn’t
open the Function Block Parameters dialog. So if changing the implementation is required,
one has to open the dialog via Mask Parameters command of the context menu.

Developer note: To get the double-click feature the callback function of OpenFnc in Block
Properties is manually altered to

1 if get_param(gcb ,'Toggle ') == '0'

2 set_param(gcb ,'Toggle ', '1');

3 else

4 set_param(gcb ,'Toggle ', '0');

5 end

6 setBlockData(gcs , gcb);

7 initSFunction(gcb);

Implementations:

Bool Boolean Implementation

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation
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Implementation: Bool

Boolean Implementation

Inports Data Type

In1 bool

In2 bool

Outports Data Type

Out bool

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In1 int8

In2 int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In1 int16

In2 int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In1 int32

In2 int32
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Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In1 float32

In2 float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In1 float64

In2 float64

Outports Data Type

Out float64
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Block: Maximum

Inports

In1 Input #1

In2 Input #2

Outports

Out Maximum of Input #1 and Input #2

Description:

Outputs the greater value of the two input signals.

Calculation:
Out = max (In1, In2)

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In1 int16

In2 int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In1 int32

In2 int32
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Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In1 float32

In2 float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In1 float64

In2 float64

Outports Data Type

Out float64
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Block: Minimum

Inports

In1 Input #1

In2 Input #2

Outports

Out Minimum of Input #1 and Input #2

Description:

Outputs the lesser value of the two input signals.

Calculation:
Out = min (In1, In2)

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In1 int16

In2 int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In1 int32

In2 int32
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Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In1 float32

In2 float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In1 float64

In2 float64

Outports Data Type

Out float64
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Block: Not

Inports

In

Outports

Out

Description:

Logical inverter block.

Implementations:

Bool Boolean Implementation

Implementation: Bool

Boolean Implementation

Inports Data Type

In bool

Outports Data Type

Out bool
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Block: Or

Inports

In1

In2

Outports

Out

Description:

Logical OR block.

Implementations:

Bool Boolean Implementation

Implementation: Bool

Boolean Implementation

Inports Data Type

In1 bool

In2 bool

Outports Data Type

Out bool
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Block: Outport

Outports

OUT Signal to frame program

Mask Parameters

ts_fact Multiplication factor of base sampling time (in integer
format)

Gain Gain value used in simulation

Offset Offset value used in simulation

Description:

Serves as interface to the frame program. The output of this block is intended for simulation
purposes and can be left unconnected if not used. Also the parameters Gain, and Offset are
only used during simulation. The schematic for simulation can be seen in the figure below.
The Unit Delay block is only used during simulation and should reflect the time delay caused
by a discrete controller.
Note: Currently, Gain and Offset parameters are only available in Matlab/Simulink.

Data Types:

int8 8 Bit Fixed Point

int16 16 Bit Fixed Point

int32 32 Bit Fixed Point

float32 32 Bit Floating Point

float64 64 Bit Floating Point
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Block: RateLimiter

Inports

In

Init Value which is loaded at rising flanke of enable signal

Enable Enable == 0: Deactivation of block; Out is set to In.
Enable != 0: Activation of block; Out is rate limited.
Enable 0->1: Preloading of output; Out is set to value of Init
input

Outports

Out

Mask Parameters

Name ID Description

Tr 1 Rising time in seconds. Slew rate will be 1/Tr

Tf 2 Falling time in seconds. Slew rate will be 1/Tf

ts_fact 3 Multiplication factor of base sampling time (in
integer format)

Description:

Limitation of rising and falling rate.
Function of Enable:
0: rate limiting disabled, signal is passed through
1: rate limiting enabled, signal is rate limited
0->1: preload of output with value from init input

Rising and falling time refer to a step from 0 to 1. Entries for Tr: Rising time and Tf: Falling
time smaller than the actual sample time will be limited to the sample time internally.
The 16- and 32-Bit fixed point implementations are based on an internal 32-Bit wide slew-rate
variable while the 8-Bit fixed point implementation uses a 16-Bit wide slew-rate variable.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation
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Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Init int16

Enable bool

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Init int32

Enable bool

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Init float32

Enable bool

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation
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Inports Data Type

In float64

Init float64

Enable bool

Outports Data Type

Out float64
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Block: Real2Int

Inports

In Real input

Outports

Out Integer output

Mask Parameters

Name ID Description

Scale 1 Scaling factor from real to integer

Description:

Conversion block from real (floating point) datatypes to integer (fixed point) datatypes.
Out = In / Scale

Implementations:

Float32_FiP8 32 Floating Point to 8 Bit Fixed Point Implementation

Float32_FiP16 32 Floating Point to 16 Bit Fixed Point Implementation

Float32_FiP32 32 Floating Point to 32 Bit Fixed Point Implementation

Float64_FiP8 64 Floating Point to 8 Bit Fixed Point Implementation

Float64_FiP16 64 Floating Point to 16 Bit Fixed Point Implementation

Float64_FiP32 64 Floating Point to 32 Bit Fixed Point Implementation

Float32_Bool 32 Floating Point to Boolean Implementation

Float64_Bool 64 Floating Point to Boolean Implementation

Implementation: Float32_FiP8

32 Floating Point to 8 Bit Fixed Point Implementation

Inports Data Type

In float32

Outports Data Type

Out int8
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Implementation: Float32_FiP16

32 Floating Point to 16 Bit Fixed Point Implementation

Inports Data Type

In float32

Outports Data Type

Out int16

Implementation: Float32_FiP32

32 Floating Point to 32 Bit Fixed Point Implementation

Inports Data Type

In float32

Outports Data Type

Out int32

Implementation: Float64_FiP8

64 Floating Point to 8 Bit Fixed Point Implementation

Inports Data Type

In float64

Outports Data Type

Out int8

Implementation: Float64_FiP16

64 Floating Point to 16 Bit Fixed Point Implementation

Inports Data Type

In float64

Outports Data Type

Out int16
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Implementation: Float64_FiP32

64 Floating Point to 32 Bit Fixed Point Implementation

Inports Data Type

In float64

Outports Data Type

Out int32

Implementation: Float32_Bool

32 Floating Point to Boolean Implementation

Inports Data Type

In float32

Outports Data Type

Out bool

Implementation: Float64_Bool

64 Floating Point to Boolean Implementation

Inports Data Type

In float64

Outports Data Type

Out bool
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Block: Saturation

Inports

In Input

Outports

Out Limited output

Mask Parameters

Name ID Description

max 1 Upper Limit

min 2 Lower Limit

Description:

Saturation of output to adjustable upper and lower limit.

If the entry for Upper Limit is lower than the entry for Lower Limit then the limits will be
swapped internally.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation
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Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: SaveSignal

Inports

In Input signal to be saved

Description:

Makes the incoming signal accessible for reading with parameter numbers.

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32
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Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64
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Block: Selector

Inports

In0 Input #0

In1 Input #1

In2 Input #2

In3 Input #3

In4 Input #4

In5 Input #5

In6 Input #6

In7 Input #7

Select Input select

Outports

Out Selected input signal

Description:

Passing through of input signal selected by the select inport:
Select = 0 (DSP): Out = In0
Select = 1 (DSP): Out = In1
...
Select = 7 (DSP): Out = In7

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation
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Inports Data Type

In0 int8

In1 int8

In2 int8

In3 int8

In4 int8

In5 int8

In6 int8

In7 int8

Select int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In0 int16

In1 int16

In2 int16

In3 int16

In4 int16

In5 int16

In6 int16

In7 int16

Select int8

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation
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Inports Data Type

In0 int32

In1 int32

In2 int32

In3 int32

In4 int32

In5 int32

In6 int32

In7 int32

Select int8

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In0 float32

In1 float32

In2 float32

In3 float32

In4 float32

In5 float32

In6 float32

In7 float32

Select int8

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation
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Inports Data Type

In0 float64

In1 float64

In2 float64

In3 float64

In4 float64

In5 float64

In6 float64

In7 float64

Select int8

Outports Data Type

Out float64
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Block: Sequencer

Inports

Start Start signal. Rising flank triggers sequence

Outports

Out1 Output #1

Out2 Output #2

Out3 Output #3

Out4 Output #4

Mask Parameters

Name ID Description

Delay1 1 Time delay for output 1

Delay2 2 Time delay for output 2

Delay3 3 Time delay for output 3

Delay4 4 Time delay for output 4

ts_fact 5 Multiplication factor of base sampling time (in
integer format)

Description:

Generation of time delayed (enable) sequence.

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation
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Inports Data Type

Start int8

Outports Data Type

Out1 int8

Out2 int8

Out3 int8

Out4 int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

Start int16

Outports Data Type

Out1 int16

Out2 int16

Out3 int16

Out4 int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

Start int32

Outports Data Type

Out1 int32

Out2 int32

Out3 int32

Out4 int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

Start float32
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Outports Data Type

Out1 float32

Out2 float32

Out3 float32

Out4 float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

Start float64

Outports Data Type

Out1 float64

Out2 float64

Out3 float64

Out4 float64
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Block: Sin2Limiter

Inports

In

Init Value which is loaded at rising flanke of enable signal

Enable Enable == 0: Deactivation of block; Out is set to zero.
Enable != 0: Activation of block; Out is rate limited.
Enable 0->1: Preloading of output; Out is set to value of Init
input

Outports

Out

Mask Parameters

Name ID Description

Tr 1 Rising time in seconds. Slew rate will be 1/Tr

Tf 2 Falling time in seconds. Slew rate will be 1/Tf

ts_fact 3 Multiplication factor of base sampling time (in
integer format)

Description:

Limitation of rising and falling rate with sin^2 characteristic.
Note: A running limitation process can not be interrupted!
Function of Enable:
0: rate limiting disabled, signal is set to zero
1: rate limiting enabled, signal is rate limited
0->1: preload of output with value from init input

Rising and falling time refer to a step from 0 to 1. Entries for Tr: Rising time and Tf: Falling
time smaller than the actual sample time will be limited to the sample time internally.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

197



Inports Data Type

In int16

Init int16

Enable bool

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Init int32

Enable bool

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Init float32

Enable bool

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Init float64

Enable bool
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Outports Data Type

Out float64
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Block: Sin3Gen

Inports

A Amplitude

f Frequency

Outports

u Sine wave output phase u

v Sine wave output phase v

w Sine wave output phase w

Mask Parameters

Name ID Description

fmax 1 Maximum Frequency in Hz

Offset 2 Offset

ts_fact 3 Multiplication factor of base sampling time (in
integer format)

Description:

Generation of a 3 sine waves with amplitude (A) and frequency (f).

Calculation fixed point implementation:

uk = Ak sin (2fkfmaxkTs) +Aoffset

vk = Ak sin

(
2fkfmaxkTs −

2π

3

)
+Aoffset

wk = Ak sin

(
2fkfmaxkTs +

2π

3

)
+Aoffset

For sine calculation a lookup table with 256 entries is used. This results in a short computation
time but with the downside of reduced accuracy for the FiP32 implementation.

Calculation floating point implementation (parameter f_max is ignored):

uk = Ak sin (2πfkkTs) +Aoffset

vk = Ak sin

(
2πfkkTs −

2π

3

)
+Aoffset

wk = Ak sin

(
2πfkkTs +

2π

3

)
+Aoffset
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Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

A int16

f int16

Outports Data Type

u int16

v int16

w int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

A int32

f int32

Outports Data Type

u int32

v int32

w int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

A float32

f float32
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Outports Data Type

u float32

v float32

w float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

A float64

f float64

Outports Data Type

u float64

v float64

w float64
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Block: SinGen

Inports

A Amplitude

f Frequency

Outports

u Sine wave output

Mask Parameters

Name ID Description

fmax 1 Maximum Frequency in Hz

Offset 2 Offset

Phase 3 Phase [-Pi..Pi]

ts_fact 4 Multiplication factor of base sampling time (in
integer format)

Description:

Generation of a sine wave with amplitude (A) and frequency (f).

Calculation fixed point implementation:

uk = Ak sin (2fkfmaxkTs + ϕphase) +Aoffset

For sine calculation a lookup table with 256 entries is used. This results in a short computation
time but with the downside of reduced accuracy for the FiP32 implementation.

Calculation floating point implementation (parameter f_max is ignored):

uk = Ak sin (2πfkkTs + ϕphase) +Aoffset

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP16

16 Bit Fixed Point Implementation
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Inports Data Type

A int16

f int16

Outports Data Type

u int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

A int32

f int32

Outports Data Type

u int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

A float32

f float32

Outports Data Type

u float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

A float64

f float64

Outports Data Type

u float64
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Block: TypeConv

Inports

In

Outports

Out

Description:

Data Type Conversion

Implementations:

FiP8_16 8 to 16 Bit Fixed Point Implementation

FiP8_32 8 to 32 Bit Fixed Point Implementation

FiP16_8 16 to 8 Bit Fixed Point Implementation

FiP16_32 16 to 32 Bit Fixed Point Implementation

FiP32_8 32 to 8 Bit Fixed Point Implementation

FiP32_16 32 to 16 Bit Fixed Point Implementation

Bool_FiP16 Boolean to 16 Bit Fixed Point Implementation

Bool_FiP32 Boolean to 32 Bit Fixed Point Implementation

FiP16_Bool 16 Bit Fixed Point to Boolean Implementation

FiP32_Bool 32 Bit Fixed Point to Boolean Implementation

Implementation: FiP8_16

8 to 16 Bit Fixed Point Implementation

Inports Data Type

In int8

Outports Data Type

Out int16

Implementation: FiP8_32

8 to 32 Bit Fixed Point Implementation
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Inports Data Type

In int8

Outports Data Type

Out int32

Implementation: FiP16_8

16 to 8 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int8

Implementation: FiP16_32

16 to 32 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int32

Implementation: FiP32_8

32 to 8 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int8

Implementation: FiP32_16

32 to 16 Bit Fixed Point Implementation
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Inports Data Type

In int32

Outports Data Type

Out int16

Implementation: Bool_FiP16

Boolean to 16 Bit Fixed Point Implementation

Inports Data Type

In bool

Outports Data Type

Out int16

Implementation: Bool_FiP32

Boolean to 32 Bit Fixed Point Implementation

Inports Data Type

In bool

Outports Data Type

Out int32

Implementation: FiP16_Bool

16 Bit Fixed Point to Boolean Implementation

Inports Data Type

In int16

Outports Data Type

Out bool

Implementation: FiP32_Bool

32 Bit Fixed Point to Boolean Implementation
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Inports Data Type

In int32

Outports Data Type

Out bool
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Block: uConstant

Outports

Out Constant output

Mask Parameters

Name ID Description

Value 1 Constant factor

Description:

Constant value.

Implementations:

Bool Boolean Integration

Int8 8 Bit Integer Implementation

Int16 16 Bit Integer Implementation

Int32 32 Bit Integer Implementation

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: Bool

Boolean Integration

Outports Data Type

Out bool

Implementation: Int8

8 Bit Integer Implementation

Outports Data Type

Out int8
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Implementation: Int16

16 Bit Integer Implementation

Outports Data Type

Out int16

Implementation: Int32

32 Bit Integer Implementation

Outports Data Type

Out int32

Implementation: FiP8

8 Bit Fixed Point Implementation

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Outports Data Type

Out float32
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Implementation: Float64

64 Bit Floating Point Implementation

Outports Data Type

Out float64
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Block: uGain

Inports

In Input

Outports

Out Amplified input

Mask Parameters

Name ID Description

Gain 1 Gain factor in floating point format

Description:

Amplification of input by gain factor with output wrapping.

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation
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Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: uRateLimiter

Inports

In

Init Value which is loaded at rising flanke of enable signal

Enable Enable == 0: Deactivation of block; Out is set to In.
Enable != 0: Activation of block; Out is rate limited.
Enable 0->1: Preloading of output; Out is set to value of Init
input

Outports

Out

Mask Parameters

Name ID Description

Tr 1 Rising time in seconds. Slew rate will be 1/Tr

Tf 2 Falling time in seconds. Slew rate will be 1/Tf

ts_fact 3 Multiplication factor of base sampling time (in
integer format)

Description:

Limitation of rising and falling rate.
Function of Enable:
0: rate limiting disabled, signal is passed through
1: rate limiting enabled, signal is rate limited
0->1: preload of output with value from init input

Rising and falling time refer to a step from 0 to 1. Entries for Tr: Rising time and Tf: Falling
time smaller than the actual sample time will be limited to the sample time internally.
The 16- and 32-Bit fixed point implementations are based on an internal 32-Bit wide slew-rate
variable while the 8-Bit fixed point implementation uses a 16-Bit wide slew-rate variable.

Implementations:

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation
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Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Init int16

Enable bool

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Init int32

Enable bool

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Init float32

Enable bool

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation
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Inports Data Type

In float64

Init float64

Enable bool

Outports Data Type

Out float64
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Block: uSaveSignal

Inports

In Input signal to be saved

Description:

Makes the incoming signal accessible for reading with parameter numbers.

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32
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Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64
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Block: Xor

Inports

In1

In2

Outports

Out

Description:

Logical XOR block.

Implementations:

Bool Boolean Implementation

Implementation: Bool

Boolean Implementation

Inports Data Type

In1 bool

In2 bool

Outports Data Type

Out bool
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88 Math

Block: Abs

Inports

In Input u

Outports

Out Absolute value of u

Description:

Calculation of absolute value of input.

Calculation:

Out = |In|

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation
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Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: Add

Inports

In1 Addend 1

In2 Addend 2

Outports

Out Sum

Description:

Addition of input 1 and input 2.

Calculation:

Out = In1 + In2

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In1 int8

In2 int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation
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Inports Data Type

In1 int16

In2 int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In1 int32

In2 int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In1 float32

In2 float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In1 float64

In2 float64

Outports Data Type

Out float64

223



Block: Atan2

Inports

y

x

Outports

Out Result of atan2(y/x)

Description:

Computation of the angle between the inputs x and y.

Calculation:

Out =



arctan
( y
x

)
x > 0

arctan
( y
x

)
+ π x < 0, y ≥ 0

arctan
( y
x

)
− π x < 0, y < 0

+π
2 x = 0, y > 0

−π
2 x = 0, y < 0

0 x = 0, y = 0

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

y int8

x int8

Outports Data Type

Out int8
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Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

y int16

x int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

y int32

x int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

y float32

x float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

y float64

x float64
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Outports Data Type

Out float64
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Block: Average

Inports

In Input value

Outports

Out Averaged value

Mask Parameters

Name ID Description

n 1 Number of points to be averaged over

ts_fact 2 Multiplication factor of base sampling time (in
integer format)

Description:

Calculation of moving average value over n numbers.

Calculation:

Outk =
1

n

k∑
i=k−n

Ini

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Outports Data Type

Out int8
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Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: Cos

Inports

In Input u

Outports

Out Result of cos(u)

Description:

Cosine computation of input value.

Calculation:
Out = cos (In)

Error for 16 Bit Fixed Point Implementation:

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8
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Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64
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Outports Data Type

Out float64
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Block: Div

Inports

Num Dividend (Numerator)

Den Divisor (Denominator)

Outports

Out Quotient

Description:

Division of input Num by input Den.

Calculation:

Out =


0 Num = 0,Den = 0

max Num > 0,Den = 0

min Num < 0,Den = 0
Num
Den otherwise

Note: maxVal and minVal refer to the maximum/minimum representable value of the
implementation.

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

Num int8

Den int8

Outports Data Type

Out int8
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Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

Num int16

Den int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

Num int32

Den int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

Num float32

Den float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

Num float64

Den float64

233



Outports Data Type

Out float64
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Block: Exp

Inports

In Input u

Outports

Out Result of exp(u)

Description:

Computation of the exponential of the input.

Calculation Floating Point Implementation:

Out = eIn

Calculation Fixed Point Implementation:

Out =

{
eIn In ≤ 0

1 In > 0

Error for 16 Bit Fixed Point Implementation:

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation
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Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32
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Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: L2Norm

Inports

u1 Input u1

u2 Input u2

Outports

Out Euclidean norm of u1 and u2

Description:

Calculation of L2-norm (euclidean norm).

Calculation:

Out = ∥u∥ =
√
u21 + u22

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

u1 int8

u2 int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation
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Inports Data Type

u1 int16

u2 int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

u1 int32

u2 int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

u1 float32

u2 float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

u1 float64

u2 float32

Outports Data Type

Out float64
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Block: Mult

Inports

In1 Multiplicand 1

In2 Multiplicand 2

Outports

Out Product

Description:

Multiplication of input 1 with input 2.

Calculation:

Out = In1 · In2

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In1 int8

In2 int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation
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Inports Data Type

In1 int16

In2 int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In1 int32

In2 int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In1 float32

In2 float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In1 float64

In2 float64

Outports Data Type

Out float64
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Block: Negation

Inports

In Input

Outports

Out Negated input value

Description:

Negation of input signal.

Calculation:

Out = −In

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16
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Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: Sign

Inports

In Input u

Outports

Out Value corresponding to sign of u

Description:

Signum function.

Calculation:

Out = sgn (In) =

{
1 In ≥ 0

−1 In < 0

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16
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Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64

Outports Data Type

Out float64
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Block: Sin

Inports

In Input u

Outports

Out Result of sin(u)

Description:

Sine computation of input value.

Calculation:
Out = sin (In)

Error for 16 Bit Fixed Point Implementation:

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8
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Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64
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Outports Data Type

Out float64

248



Block: Sqrt

Inports

In Input u

Outports

Out Result of sqrt(|u|)

Description:

Square root computation of absolute input value.

Calculation:

Out =
√
|In|

Error for 16 Bit Fixed Point Implementation:

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In int8
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Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In float64
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Outports Data Type

Out float64
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Block: Sub

Inports

Plus Minuend

Minus Subtrahend

Outports

Out Difference

Description:

Subtraction of input Minus from input Plus.

Calculation:

Out = Plus−Minus

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

Plus int8

Minus int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation
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Inports Data Type

Plus int16

Minus int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

Plus int32

Minus int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

Plus float32

Minus float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

Plus float64

Minus float64

Outports Data Type

Out float64
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Block: Sum

Inports

In1 Input #1

In2 Input #2

In3 Input #3

In4 Input #4

In5 Input #5

In6 Input #6

In7 Input #7

In8 Input #8

Outports

Out Result

Mask Parameters

Name ID Description

In1 1 Input #1

In2 2 Input #2

In3 3 Input #3

In4 4 Input #4

In5 5 Input #5

In6 6 Input #6

In7 7 Input #7

In8 8 Input #8

Description:

Sum of inputs:
+ ... Input will be added to result.
- ... Input will be subtracted from result.
0 ... Input will be ignored.
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Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In1 int8

In2 int8

In3 int8

In4 int8

In5 int8

In6 int8

In7 int8

In8 int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

Inports Data Type

In1 int16

In2 int16

In3 int16

In4 int16

In5 int16

In6 int16

In7 int16

In8 int16

Outports Data Type

Out int16
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Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In1 int32

In2 int32

In3 int32

In4 int32

In5 int32

In6 int32

In7 int32

In8 int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In1 float32

In2 float32

In3 float32

In4 float32

In5 float32

In6 float32

In7 float32

In8 float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation
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Inports Data Type

In1 float64

In2 float64

In3 float64

In4 float64

In5 float64

In6 float64

In7 float64

In8 float64

Outports Data Type

Out float64
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Block: uAdd

Inports

In1 Addend 1

In2 Addend 2

Outports

Out Sum

Description:

Addition of input 1 and input 2 with output wrapping.

Calculation:

Out = In1 + In2

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

In1 int8

In2 int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation

258



Inports Data Type

In1 int16

In2 int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

In1 int32

In2 int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

In1 float32

In2 float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

In1 float64

In2 float64

Outports Data Type

Out float64

259



Block: uSub

Inports

Plus Minuend

Minus Subtrahend

Outports

Out Difference

Description:

Subtraction of input Minus from input Plus with output wrapping.

Calculation:

Out = Plus−Minus

Implementations:

FiP8 8 Bit Fixed Point Implementation

FiP16 16 Bit Fixed Point Implementation

FiP32 32 Bit Fixed Point Implementation

Float32 32 Bit Floating Point Implementation

Float64 64 Bit Floating Point Implementation

Implementation: FiP8

8 Bit Fixed Point Implementation

Inports Data Type

Plus int8

Minus int8

Outports Data Type

Out int8

Implementation: FiP16

16 Bit Fixed Point Implementation
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Inports Data Type

Plus int16

Minus int16

Outports Data Type

Out int16

Implementation: FiP32

32 Bit Fixed Point Implementation

Inports Data Type

Plus int32

Minus int32

Outports Data Type

Out int32

Implementation: Float32

32 Bit Floating Point Implementation

Inports Data Type

Plus float32

Minus float32

Outports Data Type

Out float32

Implementation: Float64

64 Bit Floating Point Implementation

Inports Data Type

Plus float64

Minus float64

Outports Data Type

Out float64
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